
  

 

ZOBRAZOWANIA 

TERMALNE 

h.{½!wj² 

MORSKICH ς 1 

SENTINEL-3 
aŀǘŜǊƛŀƱȅ {ȊƪƻƭŜƴƛƻǿŜ aT.1 

 

 

 

 

FP CUP 

Framework Partnership Agreement on Copernicus User 

Uptake 

Instytut Geodezji i Kartografii 

¦ƴƛǿŜǊǎȅǘŜǘ DŘŀƵǎƪƛ 

 

opracowanie:  
dr YΦ .ǊŀŘǘƪŜΣ ¦ƴƛǿŜǊǎȅǘŜǘ DŘŀƵǎƪƛ 



1 | S t r o n a 
 

 

{Ǉƛǎ ǘǊŜǏŎƛ 

²ǎǘťǇ ...................................................................................................................................................................... 2 

tǊȊŜƎƭŊŘŀƴƛŜ ƛ ǇƻōƛŜǊŀƴƛŜ ŘŀƴȅŎƘ ........................................................................................................................... 2 

Eumetsat CODA i CODAREP ................................................................................................................................ 2 

Logowanie do serwisu ..................................................................................................................................... 2 

Wyszukiwanie danych ..................................................................................................................................... 2 

Pobieranie danych ........................................................................................................................................... 5 

Eumetsat Data Centre ......................................................................................................................................... 6 

Logowanie do serwisu ..................................................................................................................................... 6 

Wyszukiwanie danych ..................................................................................................................................... 6 

Pobieranie danych ......................................................................................................................................... 10 

Struktura danych Sentinel-3 / SLSTR ..................................................................................................................... 11 

²ǎǘťǇƴŜ ǇǊȊŜǘǿŀǊȊŀƴƛŜ ŘŀƴȅŎƘ ǿ ǇǊƻƎǊŀƳƛŜ {b!t............................................................................................. 13 

²ȅǏǿƛŜǘƭŀƴƛŜ danych ........................................................................................................................................ 13 

Przygotowanie mapy SST .................................................................................................................................. 16 

Wycinanie podobszaru .................................................................................................................................. 16 

Projekcja do odwzorowania kartograficznego .............................................................................................. 18 

Wykorzystanie masek ................................................................................................................................... 20 

tǊȊŜƭƛŎȊŜƴƛŜ {{¢ Řƻ ϲ/ ƛ ǿƛȊǳŀƭƛȊŀŎƧŀ ƳŀǇȅ ǘŜƳǇŜǊŀǘǳǊȅ ............................................................................... 22 

Eksport obrazu lub danych ............................................................................................................................ 25 

tƻǊƽǿƴŀƴƛŜ ŘŀƴȅŎƘ ȊŜ ǎŎŜƴȅ ǇƻǊŀƴƴŜƧ ƛ ǿƛŜŎȊƻǊƴŜƧ......................................................................................... 27 

Automatyzacja procesu przetwarzania danych ............................................................................................ 27 

tƻǊƽǿƴŀƴƛŜ ǿƛȊǳŀƭƴŜ .................................................................................................................................... 30 

!ƴŀƭƛȊŀ ǇƻǊƽǿƴŀǿŎȊŀ.................................................................................................................................... 31 

Interpretacja danych ς potencjalne problemy ...................................................................................................... 33 

Podsumowanie ...................................................................................................................................................... 34 

tƻŘȊƛťƪƻǿŀƴƛŀ ς Acknowledgments ..................................................................................................................... 35 

 

  



2 | S t r o n a 
 

²{¢Bt 

W niniejszym poradniku ȊƻǎǘŀƴŊ ǇǊȊŜŘǎǘŀǿƛƻƴŜ ƛƴŦƻǊƳŀŎƧŜ ƻ ǘȅƳ jak ǇǊȊŜƎƭŊŘŀŏ ƛ ǇƻȊȅǎƪƛǿŀŏ ŘŀƴŜ czujnika SLSTR 

(Sentinel-3) dla obszaru morzaΣ ƪƻǊȊȅǎǘŀƧŊŎ Ȋ ǎŜǊǿƛǎƽǿ ƛƴǘŜǊƴŜǘƻǿȅŎƘ ǘŀƪƛŎƘ ƧŀƪΥ CODA Eumetsat i Eumetsat Data 

Centre ƻǊŀȊ Ƨŀƪ ǇǊȊȅƎƻǘƻǿŀŏ ƧŜ Řƻ ŘŀƭǎȊŜƧ ǇǊŀŎȅ ǿ DL{ Ȋŀ ǇƻƳƻŎŊ ƻǇǊƻƎǊŀƳƻǿŀƴƛŀ {b!tΦ  

Czujnik SLSTR (Sea and Land Surface Temperature Radiometer) rejestruje promieniowanie w zakresie VNIR, SWIR 

oraz TIR. Do poziomu L2 ŘŀƴŜ ǇǊȊŜǘǿŀǊȊŀƴŜ ǎŊ ƻŘŘȊƛŜƭƴƛŜ Řƭŀ ƻōǎȊŀǊǳ ƭŊŘǳ ƛ ƳƻǊȊŀΦ tǊƻŘǳƪǘȅ Řƭŀ ƻōǎȊŀǊǳ ƳƻǊȊŀ, 

ȊŀǿƛŜǊŀƧŊŎŜ ŘŀƴŜ ƻ ǘŜƳǇŜǊŀǘǳǊȊŜ ǇƻǿƛŜǊȊŎƘƴƛ ƳƻǊȊŀ ŘƻǎǘťǇƴŜ ǎŊ ǿȅƱŊŎȊƴƛŜ ǇƻǇǊȊŜȊ ǎŜǊǿƛǎȅ agencji EUMETSAT.  

tw½9D[+5!bL9 L th.L9w!bL9 5!b¸/I 

EUMETSAT CODA I CODAREP 

LOGOWANIE DO SERWISU 

²ǇƛǎȊ ǿ ǇǊȊŜƎƭŊŘŀǊŎŜ ŀŘǊŜǎ ǎŜǊǿƛǎǳΥ https://coda.eumetsat.int/. Zostaniesz przekierowany do strony logowania. 

² ǇǊȊȅǇŀŘƪǳ ōǊŀƪǳ ƪƻƴǘŀΣ ƴŀƭŜȍȅ ƧŜ ȊŀƱƻȍȅŏ ƪƭƛƪŀƧŊŎ NEW USER ς CREATE NEW ACCOUNT. Bez rejestracji 

i ƭƻƎƻǿŀƴƛŀ ƴƛŜ ƧŜǎǘ ƳƻȍƭƛǿŜ ƪƻǊȊȅǎǘŀƴƛŜ Ȋ ŦǳƴƪŎƧƻƴŀƭƴƻǏŎƛ ǎŜǊǿƛǎǳΦ wŜƧŜǎǘǊŀŎƧŀ ƧŜǎǘ ōŜȊǇƱŀǘƴŀ ƛ ǇǊƻǎǘŀ ς wymaga 

ǇƻŘŀƴƛŀ ƧŜŘȅƴƛŜ ƪƛƭƪǳ ƛƴŦƻǊƳŀŎƧƛ ƴŀ ǘŜƳŀǘ ǳȍȅǘƪƻǿƴƛƪŀΦ ¦Ȋȅǎƪŀƴȅ ƭƻƎƛƴ ƛ ƘŀǎƱƻ ƻōƻǿƛŊȊǳƧŊ ǿŜ ǿǎȊȅǎǘƪƛŎƘ 

serwisach EUMETSAT (CODA, CODAREP i DATA CENTRE). 

 

WYSZUKIWANIE DANYCH 

Serwis CODA ǇƻȊǿŀƭŀ ƴŀ ǇǊȊŜǎȊǳƪƛǿŀƴƛŜ ōŀȊȅ ŘŀƴȅŎƘ ƴŀ ǇƻŘǎǘŀǿƛŜ ƪƛƭƪǳ ƪǊȅǘŜǊƛƽǿ. Uwaga!!!  ² ǊƽȍƴȅŎƘ 

ǇǊȊŜƎƭŊŘŀǊƪŀŎƘ ƛƴǘŜǊƴŜǘƻǿȅŎƘ ǎǘǊƻƴŀ ƳƻȍŜ ǿȅƎƭŊŘŀŏ ǊƽȍƴƛŜΦ tǊȊŜŘǎǘŀǿƛƻƴŜ ǘǳ ǇǊȊȅƪƱŀŘȅ ȊƻǎǘŀƱȅ ǇǊȊȅƎƻǘƻǿŀƴŜ 

z wykorzystaniem Mozilla Firefox. 

https://coda.eumetsat.int/
https://archive.eumetsat.int/usc/
https://archive.eumetsat.int/usc/
https://coda.eumetsat.int/
https://coda.eumetsat.int/
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5ŜŦƛƴƛƻǿŀƴƛŜ ǇŀǊŀƳŜǘǊƽǿ ǿȅǎȊǳƪƛǿŀƴƛŀ ƴŀƧƭŜǇƛŜƧ ǊƻȊǇƻŎȊŊŏ ƻŘ ȊŀȊƴŀŎȊŜƴƛŀ ƻōǎȊŀǊǳ ȊŀƛƴǘŜǊŜǎƻǿania. W tym 

ŎŜƭǳ ƴŀƭŜȍȅ ǿȅōǊŀŏ ƻǇŎƧť Polygon όǇŀǘǊȊ ŎȊŜǊǿƻƴŀ ǎǘǊȊŀƱƪŀ ǳ ŘƻƱǳ ƴŀ ǇƻǿȅȍǎȊȅƳ ƻōǊŀȊƛŜύΦ wȅǎƻǿŀƴƛŜ ǇƻƭƛƎƻƴǳ 

ƻŘōȅǿŀ ǎƛť ǇƻǇǊȊŜȊ ȊŀȊƴŀŎȊŀƴƛŜ ƴŀ ƳŀǇƛŜ Ǉǳƴƪǘƽǿ lewym ƪƭŀǿƛǎȊŜƳ ƳȅǎȊȅΦ !ōȅ ȊŀƳƪƴŊŏ ǇƻƭƛƎƻƴ ƛ ȊŀƪƻƵŎȊȅŏ 

ǊȅǎƻǿŀƴƛŜ ƴŀƭŜȍȅ ƪƭƛƪƴŊŏ prawym ƪƭŀǿƛǎȊŜƳ ƳȅǎȊȅΦ tƻƭƛƎƻƴ ȊƻǎǘŀƴƛŜ ǇƻŘǏǿƛŜǘƭƻƴȅ ƴŀ ȍƽƱǘƻΦ !ōȅ ƳƽŎ ǇǊȊŜǎǳǿŀŏ 

ƳŀǇť ǇƻȊƻǎǘŀǿƛŀƧŊŎ ǇƻƭƛƎƻƴΣ ƴŀƭŜȍȅ ǇǊȊŜƧǏŏ Řƻ ǘǊȅōǳ PanΦ ²ȅǎȊǳƪƛǿŀƴŜ ōťŘŊ ǿǎȊȅǎǘƪƛŜ ŘŀƴŜΣ ƪǘƽǊŜ ǇǊȊȅƴŀƧƳƴƛŜƧ 

ŎȊťǏŎƛƻǿƻ ǇƻƪǊȅǿŀƧŊ ȊŀŘŀƴȅ ƻōǎȊŀǊΦ !ōȅ ƻƎǊŀƴƛŎȊȅŏ ŘŀƭŜƧ ǿȅǎȊǳƪƛǿŀƴƛŜ ƴŀƭŜȍȅ ƪƭƛƪƴŊŏ ƛƪƻƴť Ǉƻ ƭŜǿŜƧ ǎǘǊƻƴƛŜ 

okienka Insert search criteriaΦ wƻȊǿƛƴƛŜ ǎƛť ƭƛǎǘŀ ǇƻȊǿŀƭŀƧŊŎŀ ȊŘŜŦƛƴƛƻǿŀŏ ǇŀǊŀƳŜǘǊȅ ǇǊȊŜǎȊǳƪƛǿŀƴƛŀ 

i ǿȅǏǿƛŜǘƭŀƴƛŀ ǿȅƴƛƪƽǿΥ  

Sortowanie (Sort By) - ǿȅōƽǊ ǎǇƻǎƻōǳ ǎƻǊǘƻǿŀƴƛŀ ǿȅǎȊǳƪƛǿŀƴȅŎƘ ƻōǊŀȊƽǿ:  

¶ Ingestion date - wg. daǘȅ αǇǊȊȅƧťŎƛŀέ danych (produktu) do bazy danych; 

¶ Sensing date ς wg. daty wykonania zobrazowania; 

¶ Cloud Coverage ς wg. stopnia pokrycia chmurami sceny 

Kierunek sortowania (Order by) ς ǿȅōƽǊ ƪƛŜǊǳƴƪǳ ǎƻǊǘƻǿŀƴƛŀ ǿȅƴƛƪƽǿ 

¶ Descending - ƳŀƭŜƧŊŎƻ 

¶ Ascending - ǊƻǎƴŊco 

Okres (Sensing period/Ingestion period) ς ǿȅōƽǊ Řŀǘ ǿ ǊŀƳŀŎƘΣ ƪǘƽǊȅŎƘ ǳȍȅǘƪƻǿƴƛƪ ŘƻƪƻƴǳƧŜ ǿȅǎȊǳƪƛǿŀƴƛŀΦ  

UWAGA!!!  W ǎŜǊǿƛǎƛŜ /h5! ǳŘƻǎǘťǇƴƛŀƴŜ ǎŊ ŘŀƴŜ Řƻ Ǌƻƪǳ ǿǎǘŜŎȊΦ ²ŎȊŜǏƴƛŜƧǎȊŜ ŘŀƴŜ, z okresu 19/04/2016 do 

04/04/2018 ŘƻǎǘťǇƴŜ ǎŊ ǿ ǎŜǊǿƛǎƛŜ /h5!w9t όhttps://codarep.eumetsat.int/ύΣ Řƻ ƪǘƽǊŜƎƻ ȊŀƭƻƎƻǿŀŏ ǎƛť Ƴƻȍƴŀ 

Ȋŀ ǇƻƳƻŎŊ tego samego ƭƻƎƛƴǳ ƛ ƘŀǎƱŀΦ WŜƎƻ ŦǳƴƪŎƧƻƴŀƭƴƻǏŏ ƧŜǎǘ ǘŀƪŀ ǎŀƳŀ jak opisana tu dla CODA. Dane 

zarejestrowane po 04/04/2018Σ ƪǘƽǊŜ ƴƛŜ ǎŊ Ƨǳȍ ŘƻǎǘťǇƴŜ ǿ /h5! Ƴƻȍƴŀ ǇƻȊȅǎƪŀŏ Ȋŀ ǇƻƳƻŎŊ EUMETSAT Data 

Centre (patrz ƴŀǎǘťǇƴȅ ǊƻȊŘȊƛŀƱ). 

bŀǎǘťǇƴƛŜ Ƴƻȍƴŀ ȊŀǿťȊƛŏ ǿȅǎȊǳƪƛǿŀƴƛŜ ǿȅǇŜƱƴƛŀƧŊŎ ƛƴŦƻǊƳŀŎƧŜ ǿ ƧŜŘƴȅƳ ƭǳō ƪƛƭƪǳ ƴŀǎǘťǇǳƧŊŎȅŎƘ ŦƛƭǘǊŀŎƘ: 

¶ Instrument (Instrument)  

¶ Poziom przetworzenia (Product Level): 

o L0 ς dane surowe 

o L1 ς dane po korekcji instrumentalnej i geolokacjiΣ ǊŀŘƛŀŎƧŀ ƛ ǘŜƳǇŜǊŀǘǳǊŀ ǊŀŘƛŀŎȅƧƴŀ ǿ ƪŀƴŀƱŀŎƘ 

ǎǇŜƪǘǊŀƭƴȅŎƘ Řƭŀ ƻōǳ ǘǊȅōƽǿ ǊŜƧŜǎǘǊŀŎƧƛ όƴŀŘƛǊƻǿŜƧ ƛ ǳƪƻǏƴŜƧύ 

https://codarep.eumetsat.int/
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o L2 ς dane po korekcji atmosferycznej, temperatura powierzchni morza (skin temperature).  

¶ ǘǊȅō ǳŘƻǎǘťǇƴƛŀƴƛŀ (Timeliness) - w przypadku SLSTR ŘŀƴŜ ǎŊ ǳŘƻǎǘťǇƴƛŀƴŜ ǿ н ǘǊȅōŀŎƘ 

o NRT (Near Real Time) ς produkty ǳŘƻǎǘťǇƴƛŀƴŜ Ƨǳȍ ǿ ŎƛŊƎǳ о ƎƻŘȊƛƴ Ǉƻ ǊŜƧŜǎǘracji, ale mniej 

ŘƻƪƱŀŘƴƛŜ ǇǊȊŜǘǿƻǊȊƻƴŜ όǿ ǎȊŎȊŜƎƽƭƴƻǏŎƛ ƳƴƛŜƧ ŘƻƪƱŀŘƴŜ ŘŀƴŜ ƎŜƻǊŜŦŜǊŜƴŎȅƧƴŜύ ς 

przechowywane w bazie do ƳƛŜǎƛŊŎŀ od rejestracji 

o NTC (Non Time Critical) ς produkty ǳŘƻǎǘťǇƴƛŀƴŜ Ȋ ƻǇƽȋƴƛŜƴƛŜƳ do miŜǎƛŊŎŀ Ǉƻ ǊŜƧŜǎǘǊŀŎƧƛ, ale 

ǇǊȊŜǿŀȍƴƛŜ Ƨǳȍ ǿ ŎƛŊƎǳ нп-48h όŀƭƎƻǊȅǘƳȅ ǿȅƪƻǊȊȅǎǘǳƧŊ ōŀǊŘȊƛŜƧ ǇǊŜŎȅȊȅƧƴŜ ƛƴŦƻǊƳŀŎƧŜ Řƻ 

korekcji) -  przechowywane w bazie do roku od rejestracji 

ƛ κ ƭǳō ōŀǊŘȊƛŜƧ ǎȊŎȊŜƎƽƱƻǿƻΥ 

¶ produkt (Product type) ς produkty czujnika SLSTR ƳŀƧŊ ƴŀȊǿȅ ǊƻȊǇƻŎȊȅƴŀƧŊŎŜ ǎƛť ƻŘ αS[ψέΣ ƴŀǎǘťǇƴƛŜ м 

lub 2 oznacza poziom przetworzenia L1 lub L2, RBT ς radiacja i temperatura radiacyjna, WST ς 

ǘŜƳǇŜǊŀǘǳǊŀ ǇƻǿƛŜǊȊŎƘƴƛ ƳƻǊȊŀ Řƭŀ ƻōǎȊŀǊƽǿ ǿƻŘȅ όǇǊƻŘǳƪǘ [н Řƭŀ ƻōǎȊŀǊǳ ƭŊŘǳΥ {[ψнψ[{¢ ŘƻǎǘťǇƴȅ 

jest w serwisie Copernicus Access Hub) 

¶ numer cyklu (Cycle Number) ς liczba wskazuƧŊŎŀ Ǉƻ ǊŀȊ ƪǘƽǊȅ ƻŘ ǇƻŎȊŊǘƪǳ ƳƛǎƧƛ ǎŀǘŜƭƛǘŀ ȊƴŀƭŀȊƱ ǎƛť 

ŘƻƪƱŀŘƴƛŜ ƴŀŘ ǘȅƳ ǎŀƳȅƳ ǇǳƴƪǘŜƳ ƴŀ ½ƛŜƳƛ όǿ ǘǊȅōƛŜ ƻǇŜǊŀŎȅƧƴȅƳ ŘƱǳƎƻǏŏ Ŏȅƪƭǳ ǎŀǘŜƭƛǘy Sentinel-3 

wynosi 27 dni) 

¶ numer orbity (Orbit Number) ς ƭƛŎȊōŀ ǿǎƪŀȊǳƧŊŎŀ ƪƻƭŜƧƴȅ ƻōƛŜƎ ƻǊōƛǘȅ ƻŘ ǇƻŎȊŊǘƪǳ ƳƛǎƧƛ 

¶ numer ǏŎƛŜȍƪƛ (Relative Orbit Start), czyli pasa zobrazowania ƻŘǇƻǿƛŀŘŀƧŊŎŜƎƻ ƪƻƭŜƧƴȅƳ ƻōƛŜƎƻƳ 

satelity w jednym cyklu. 

¶ detected fire ς pozwaƭŀ ƴŀ ǿȅōǊŀƴƛŜ ǘȅƭƪƻ ǘȅŎƘ ǎŎŜƴΣ ƴŀ ƪǘƽǊȅŎƘ ȊƛŘŜƴǘȅŦƛƪƻǿŀƴƻ ǇƻȍŀǊȅ 

² ŏǿƛŎȊŜƴƛǳ ȊƻǎǘŀƴŊ ǿȅƪƻǊȊȅǎǘŀƴŜ ǇǊȊȅƪƱŀŘƻǿŜ ŘŀƴŜ Ȋ мпΦлсΦнлнлΦ !ōȅ ǇƻȊȅǎƪŀŏ ǇǊƻŘǳƪǘ [н ȊŀȊƴŀŎȊ ǇƻƭƛƎƻƴ 

ƻōŜƧƳǳƧŊŎȅ .ŀƱǘȅƪΣ ǎƻǊǘƻǿŀƴƛŜ Ǉƻ ŘŀŎƛŜ ǊŜƧŜǎǘǊŀŎƧƛ ǊƻǎƴŊŎƻΣ ƻƪǊŜǎ ǊŜƧŜǎǘǊŀŎƧƛ ƻŘ 14.06.2020 do 14.06.2020 oraz 

instrument SLSTR, tryb Non Time Critical, poziom przetworzenia L2. tƻȊƻǎǘŀƱŜ ŦƛƭǘǊȅ ǇƻȊƻǎǘŀǿ ǇǳǎǘŜΦ Kliknij na 

ƭǳǇťΣ ŀōȅ ǳǊǳŎƘƻƳƛŏ ǿȅǎȊǳƪƛǿŀƴƛŜΦ 

 

bŀǎǘŊǇƛ ǿȅǎȊǳƪƛǿŀƴƛŜ scenΣ ƪǘƽǊȅŎƘ ŎƘƻŏ ŎȊťǏŏ ȊƴŀƧŘǳƧŜ ǎƛť ǿ ȊŀŘŀƴȅƳ ǇƻƭƛƎƻƴƛŜΦ ² ƳƛŜƧǎŎŜ ŦƛƭǘǊƽǿ ǇƻƧŀǿƛ ǎƛť 

lista znalezionych danych i obrysy ǏŎƛŜȍŜƪ na mapie. 

http://www.scihub.copernicus.eu/
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POBIERANIE DANYCH 

½ƴŀƧŘȋ ǇǊƻŘǳƪǘ [н Řƭŀ ǎŎŜƴȅ ȊŀǊŜƧŜǎǘǊƻǿŀƴŜƧ ƻƪΦ ƎƻŘȊΦ 19Σ ƪǘƽǊŀ ƻōŜƧƳǳƧŜ .ŀƱǘȅƪ όƳƻȍŜǎȊ ǇǊȊŜǎȊǳƪŀŏ ƭƛǎǘť albo 

ƪƭƛƪŀƧŊŎ ƴŀ ƳŀǇƛŜ ǿ ƻōǊȅǎ ǏŎƛŜȍƪƛ ƻōŜƧƳǳƧŊŎej .ŀƱǘȅƪ ǇǊȊŜƧǏŏ Řƻ ƻŘǇƻǿƛŜŘƴƛŜƧ ǇƻȊȅŎƧƛ ƭƛǎǘȅύΦ Klikniecie ikony View 

tǊƻŘǳŎǘ 5Ŝǘŀƛƭǎ ǇƻȊǿŀƭŀ ŘƻƪƱŀŘƴƛŜƧ ǇǊȊȅƧǊȊŜŏ ǎƛť ǇǊȊŜōƛŜƎƻǿƛ ǏŎƛŜȍƪƛ ƛ ǎȊŎȊŜƎƽƱƻƳ ǎŎŜƴȅ 

 

 

YƭƛƪƴƛƧ ƛƪƻƴƪť Download product ǿ ƻƪƴƛŜ ǇƻŘƎƭŊŘǳ ƭǳō Ǉrzy wybranym produkcie 
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tƻƧŀǿƛ ǎƛť ƻƪƴƻ ȊŀǇƛǎǳΦ ²ȅōƛŜǊȊ ǏŎƛŜȍƪť ƛ ǇƻōƛŜǊȊ ǇƭƛƪΦ aƻȍŜ ǘƻ ȊŀƧŊŏ ƪƛƭƪŀ ƳƛƴǳǘΣ Ȋ ǊŀŎƧƛ ȊƴŀŎȊƴŜƧ ǿƛŜƭƪƻǏŎƛ ǇƭƛƪǳΦ 

tƭƛƪ ƧŜǎǘ ǿ ǇƻǎǘŀŎƛ ǎǇŀƪƻǿŀƴŜƎƻ ŀǊŎƘƛǿǳƳ ½LtΣ ƪǘƽǊŜ ƴŀƭŜȍȅ ǊƻȊǇŀƪƻǿŀŏΦ 

²ƛťŎŜƧ ƴŀ ǘŜƳŀǘ ŦǳƴƪŎƧƻƴŀƭƴƻǏŎƛ ǎŜǊǿƛǎǳ /h5! ǿ Sentinel 3 Marine Copernicus Data AccessUser Manual 

EUMETSAT DATA CENTRE 

LOGOWANIE DO SERWISU 

Dane SL{¢w [нΣ ƪǘƽǊŜ ƴƛŜ ǎŊ ŘƻǎǘťǇƴŜ ǿ ǎŜǊǿƛǎƛŜ /h5! Ƴƻȍƴŀ ȊŀƳƽǿƛŏ ǇƻǇǊȊŜȊ ǎŜǊǿƛǎ Eumetsat Data Centre. 

5ƻǘȅŎȊȅ ǘƻ ƳΦƛƴΦ ǊŜƧŜǎǘǊŀŎƧƛ ǇƻǊŀƴƴȅŎƘ ǿ ǘǊȅōƛŜ b¢/ ƻǊŀȊ ǿǎȊȅǎǘƪƛŎƘ ǊŜƧŜǎǘǊŀŎƧƛ ǎǘŀǊǎȊȅŎƘ ƴƛȍ м ǊƻƪΦ  

²ŜƧŘȋ ƴŀ ǎǘǊƻƴť Eumetsat Data Centre (https://archive.eumetsat.int/usc/Φ WŜǏƭƛ ƴƛŜ ōȅƱŜǏ ȊŀƭƻƎƻǿŀƴȅ ǿŎȊŜǏƴƛŜƧ 

Řƻ ƛƴƴŜƎƻ ǎŜǊǿƛǎǳ 9ǳƳŜǘǎŀǘ ƭǳō ǎŜǎƧŀ ǿȅƎŀǎƱŀ Ȋ ǇƻǿƻŘǳ ōǊŀƪǳ ŀƪǘȅǿƴƻǏŎƛ ȊƻǎǘŀƴƛŜǎȊ ǇǊȊŜƪƛŜǊƻǿŀƴȅ Řƻ ǎǘǊƻƴȅ 

ƭƻƎƻǿŀƴƛŀΦ ½ŀƭƻƎǳƧ ǎƛť Ȋŀ ǇƻƳƻŎŊ tego samego loginu i ƘŀǎƱŀ Ƨŀƪ ǿ ǇǊȊȅǇŀŘƪǳ ǎŜǊǿƛǎǳ /h5!Φ  

WYSZUKIWANIE DANYCH 

 

Po zalogowaniu ǿȅǏǿƛŜǘƭƛ ǎƛť ǇƻǿȅȍǎȊŀ ǎǘǊƻƴŀ. YǊƻƪ Ǉƻ ƪǊƻƪǳ ǳȍȅǘƪƻǿƴƛƪ ƳƻȍŜ Řƻƪƻƴȅǿŀŏ ǿȅōƻǊǳ ǇǊƻŘǳƪǘǳ Ȋŀ 

ǇƻƳƻŎŊ ǊƽȍƴȅŎƘ ŦƛƭǘǊƽǿΦ 

Products - ǳƳƻȍƭƛǿƛŀ ǿȅōƽǊ ǎǇƻǏǊƽŘ ǿƛŜƭǳ ǇǊƻŘǳƪǘƽǿ ƎƭƻōŀƭƴȅŎƘΦ ½ŀ ǇƻƳƻŎŊ Thematic Filter Ƴƻȍƴŀ ƻƎǊŀƴƛŎȊȅŏ 

ƭƛǎǘť ǇǊƻŘǳƪǘƽǿ Řƻ ǘȅŎƘ ȊŀǿƛŜǊŀƧŊŎȅŎƘ ǇƻǘǊȊŜōƴŜ ǇŀǊŀƳŜǘǊȅΦ ² ȊŀƪƱŀŘŎŜ Sentinel-3 DataSets ŘƻǎǘťǇƴŜ ǎŊ 

ŘƻŘŀǘƪƻǿƻ ǇǊƻŘǳƪǘȅ ǘǿƻǊȊƻƴŜ Řƭŀ ƻƪǊŜǏƭƻƴȅŎƘ ǊŜƎƛƻƴƽǿΦ 

!ōȅ ǇƻȊȅǎƪŀŏ ŘŀƴŜ L2 ƻŘǇƻǿƛŀŘŀƧŊŎŜ tym pozyskiwanym z serwisu CODA dla trybu NTC wybierz filtr tematyczny 

Sea Surface TemperatureΣ ŀ ƴŀǎǘťǇƴƛŜ ǿ ȊŀƪƱŀŘŎŜ Products: SLSTR Level 2 Sea Surface Temperature (SST) in NTC 

Sentinel-3. ² ƻƪƛŜƴƪǳ Ǉƻ ǇǊŀǿŜƧ ǎǘǊƻƴƛŜ ǇƻƧŀǿƛ ǎƛť ƻǇƛǎ ǿȅōǊŀƴŜƎƻ produktu. 

Kliknij NEXT STEP, ŀōȅ ǇǊȊŜƧǏŏ Řƻ ƴŀǎǘťǇƴŜƧ ƎǊǳǇȅ ŦƛƭǘǊƽǿΣ ƎŘȊƛŜ Ƴƻȍƴŀ ƻƎǊŀƴƛŎȊȅŏ ǿȅōƽǊ ǿƎ nazwy satelity 

(Satellite), statusu misji (Service Status, Overal QualityύΣ ǏŎƛŜȍƪƛ όRelative Orbit Number, Pass Number, Relative 

Pass Number), granuli (Frame Along Track CoordinateύΣ ǘǊȅōǳ ǳŘƻǎǘťǇƴƛŀƴƛŀ ŘŀƴȅŎƘ όTimeliness) 

https://coda.eumetsat.int/manual/CODA-user-manual.pdf
https://archive.eumetsat.int/usc/
https://archive.eumetsat.int/usc/
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!ōȅ ȊǿƛťƪǎȊȅŏ ȊŀǎƛťƎ ǿȅǎȊǳƪƛǿŀƴƛŀΣ ȊŀȊƴŀŎȊ ƻǇŎƧť All SatellitesΣ ƪǘƽǊŀ ŀǳǘƻƳŀǘȅŎȊƴƛŜ ȊŀȊƴŀŎȊȅ nazwy obu 

ǎŀǘŜƭƛǘƽǿΥ Sentinel 3A i Sentinel 3BΦ {Ŋ ǘƻ ǎŀǘŜƭƛǘȅΣ ƻ ǘŀƪƛŎƘ ǎŀƳȅŎƘ Ǉŀrametrach. UǇŜǿƴƛƧ ǎƛťΣ ȍŜ ǿȅōǊŀƴȅ ȊƻǎǘŀƱ 

tryb NTC (Timelines). 

 

Kliknij NEXT STEP, ŀōȅ ǇǊȊŜƧǏŏ Řƻ ȊŀǿťȍŜƴƛŀ ŎȊŀǎǳ ǊŜƧŜǎǘǊŀŎƧƛ 

 

Ustaw zakres dat od 14.06.2020 godz. 08:00 do 14.06.2020 godz. 10:00, ŀōȅ ǿȅǎȊǳƪŀŏ ǇƻǊŀƴƴŜ ǊŜƧŜǎǘǊŀŎƧŜΦ YƭƛƪƴƛƧ 

APPLY ǇǊȊȅ ŘŀŎƛŜ ƪƻƵŎƻǿŜƧΣ ŀōȅ ȊŀŀƪŎŜǇǘƻǿŀŏ ǳǎǘŀǿƛŜƴƛŀΦ ² ŘƻƭƴŜƧ ŎȊťǏŎƛ ƻƪƴŀ ǇƻƧŀǿƛ ǎƛť ƛƴŦƻǊƳŀŎƧŀ o tym, ile 

ǇǊƻŘǳƪǘƽǿ ƳƛŜǏŎƛ ǎƛť ǿ ȊŀŘŀƴȅƳ ƻƪƴƛŜ ŎȊŀǎƻǿȅƳΦ 

² ǇǊȊȅǇŀŘƪǳ ǿȅǎȊǳƪƛǿŀƴƛŀ ǇƻǊŀƴƴȅŎƘ ǊŜƧŜǎǘǊŀŎƧƛ Ȋ ŘƱǳȍǎȊŜƎƻ ƻƪǊŜǎǳ όƪƛƭƪǳ Řƴƛύ ȊŀƪǊŜǎ ƎƻŘȊƛƴƻǿȅ ƴŀƭŜȍȅ ǇƻŘŀŏ 

w opcji Additional Filter.  

Kliknij NEXT STEP, ŀōȅ ǇǊȊŜƧǏŏ Řƻ ȊŀǿťȍŜƴƛŀ obszaru. 
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hōǎȊŀǊ Ƴƻȍƴŀ ȊŀǿťȊƛŏ ǿȅōƛŜǊŀƧŊŎ ǇǊŜŘŜŦƛƴƛƻǿŀƴȅ ƻōǎȊŀǊ ǿ ƻǇŎƧƛ Region ƭǳō ŘŜŦƛƴƛǳƧŊŎ ǇǊƻǎǘƻƪŊǘ ƻƎǊŀƴƛŎȊƻƴȅ 

ǿǎǇƽƱǊȊťŘƴȅƳƛ ƎŜograficznymi zadanymi w opcji Upper left corner i Lower right corner. tǊƻǎǘƻƪŊǘ Ƴƻȍƴŀ 

ǊƽǿƴƛŜȍ ƴŀǊȅǎƻǿŀŏ ƴŀ ƳŀǇƛŜ ƳȅǎȊƪŊ ǇǊȊȅǘǊȊȅƳǳƧŊŎ ƭŜǿȅ ƪƭŀǿƛǎȊ ƳȅǎȊȅΦ !ōȅ ǿƛŜƭƻƪǊƻǘƴƛŜ ƪƻǊȊȅǎǘŀŏ ȊŜ 

ȊŘŜŦƛƴƛƻǿŀƴŜƎƻ ǊŜƎƛƻƴǳ Ƴƻȍƴŀ ȊŀǇƛǎŀŏ Ǝƻ ƪƭƛƪŀƧŊŎ SAVE REGION OF INTERESTΦ ¢ŀƪ ȊŀǇƛǎŀƴȅ ōťŘȊƛŜ ŘƻǎǘťǇƴȅ 

wraz z innymi regionami w opcji Region ǇǊȊȅ ƪŀȍŘȅƳ ƴŀǎǘťǇƴȅƳ ƭƻƎƻǿŀƴƛǳ Řƻ ǎŜǊǿƛǎǳΦ 

 

½ŘŜŦƛƴƛǳƧ ƻōǎȊŀǊ ƭŜȍŊŎȅ ƳƛťŘȊȅ ǿǎǇƽƱǊȊťŘƴȅƳƛ тΦсϲ ς нтΦсϲ9 ƻǊŀȊ рнΦуϲ - стΦоϲbΦ ½ŀǇƛǎȊ ǊŜƎƛƻƴ Řƻ ǿȅƪƻǊȊȅǎǘŀƴƛŀ 

ǿ ǇǊȊȅǎȊƱƻǏŎƛΦ YƭƛƪƴƛƧ NEXT STEP, ŀōȅ ǇǊȊŜƧǏŏ Řƻ ƻǇŎƧƛ ǿȅōƻǊǳ ŦƻǊƳŀǘǳ ŘŀƴȅŎƘΦ Produkt SLSTR Level 2 Sea Surface 

Temperature (SST) in NTC Sentinel-3 ŘƻǎǘťǇƴȅ ƧŜǎǘ ǿȅƱŊŎȊƴƛŜ ǿ Ŧƻrmacie Native. 

 

Kliknij NEXT STEP, ŀōȅ ǇǊȊŜƧǏŏ do wyboru sposobu dostarczenia danych. Wybierz Delivery Method: Online HTTP. 

Auxiliary data όŘƻŘŀǘƪƻǿŜ ŘŀƴŜ ƳŜǘƻǊƻƭƻƎƛŎȊƴŜύ ŘƻƱŊŎȊŀƴŜ ǎŊ ƴƛŜȊŀƭŜȍƴƛŜ ƻŘ ǿȅōǊŀƴȅŎƘ ƻǇŎƧƛ ȊƎƻŘƴƛŜ Ȋ ŘŜŦƛƴƛŎƧŊ 

standardowego produktu SLSTR Level 2 Sea Surface Temperature (SST) in NTC Sentinel-3. 

² ŘƻƭƴŜƧ ŎȊťǏŎƛ ƻƪƴŀ ǇƻƧŀǿƛ ǎƛť ƛƴŦƻǊƳŀŎƧŀ ƻ ǘȅƳΣ ƛƭŜ ǇǊƻŘǳƪǘƽǿ ƻǎǘŀǘŜŎȊƴƛŜ ǎǇŜƱƴƛŀ ȊŀŘŀƴŜ ƪǊȅǘŜǊƛŀΦ 
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Kliknij DETAILS ŀōȅ ȊƻōŀŎȊȅŏ ƭƛǎǘť ǇǊƻŘǳƪǘƽǿΦ tƻ ǿȅōǊŀƴƛǳ produktu Ȋ ƭƛǎǘȅ ǿȅǏǿƛŜǘƭŊ ǎƛť ƧŜƎƻ ǎȊŎȊŜƎƽƱȅ ƛ ǏŎƛŜȍƪŀΦ 

²ȅōƛŜǊȊ ƧŜŘŜƴ ǇǊƻŘǳƪǘΣ ƪǘƽǊŜƎƻ ǏŎƛŜȍƪŀ ƴŀƧǇŜƱƴƛŜƧ ǇƻƪǊȅǿŀ .ŀƱǘȅƪΦ ¦ǎǳƵ ǇƻȊƻǎǘŀƱŜ Ȋŀ ǇƻƳƻŎŊ REMOVE 

UNSELECTED ƛ ȊŀƳƪƴƛƧ ƻƪƴƻ ǇƻŘƎƭŊŘǳ ǇǊƻŘǳƪǘƽǿ ƪƭƛƪŀƧŊŎ CLOSE.  

 

² ƻƪƴƛŜ ǿȅōƻǊǳ ƳŜǘƻŘȅ ŘƻǎǘŀǊŎȊŜƴƛŀ ŘŀƴȅŎƘ ȊƻǎǘŀƴƛŜ ȊŀƪǘǳŀƭƛȊƻǿŀƴŀ ƭƛŎȊōŀ ƛ ƻōƧťǘƻǏŏ ǇǊƻŘǳƪǘƽǿΦ YƭƛƪƴƛƧ NEXT 

STEP, a w kolejnym oknie PLACE YOUR ORDER ǿ ŎŜƭǳ ȊƱƻȍŜƴƛŀ ȊŀƳƽǿƛŜƴƛŀΦ tƻƧŀǿƛ ǎƛť ƻƪƴƻ ORDER STATUS Ȋ ƭƛǎǘŊ 

ȊƱƻȍƻƴȅŎƘ ȊŀƳƽǿƛŜƵΦ Na adres mailowy podaƴȅ ǇƻŘŎȊŀǎ ǊŜƧŜǎǘǊŀŎƧƛ ȊƻǎǘŀƴƛŜ ǇǊȊȅǎƱŀƴȅ Ƴŀƛƭ ǇƻǘǿƛŜǊŘȊŀƧŊŎȅ 

ȊƱƻȍŜƴƛŜ ȊŀƳƽǿƛŜƴƛŀ ƻ ƴǳƳŜǊȊŜ όOrder IDύ ǿƛŘƻŎȊƴȅƳ ƴŀ ƭƛǏŎƛŜ ȊŀƳƽǿƛŜƵΦ ² ǇǊȊȅǇŀŘƪǳ ōǊŀƪǳ Ƴŀƛƭŀ ƴŀƭŜȍȅ 

ǎǇǊŀǿŘȊƛŏ ŦƻƭŘŜǊ {t!a όƳŀƛƭ Ȋ ŀŘǊŜǎǳΥ noreply@eumetsat.int). 
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POBIERANIE DANYCH 

Przetworzenie danych przez Eumetsat Data Centre ƳƻȍŜ ǇƻǘǊǿŀŏ ƻŘ ƪƛƭƪǳ Ƴƛƴǳǘ Řƻ ƪƛƭƪǳƴŀǎǘǳ ƎƻŘȊƛƴΦ tƻ 

ȊŀƪƻƵŎȊŜƴƛǳ ǇǊȊŜǘǿŀǊȊŀƴƛŀ ȊƻǎǘŀƴƛŜ ǇǊȊȅǎƱŀƴȅ Ƴŀƛƭ Ȋ ƛƴŦƻǊƳŀŎƧŀƳƛ ƻ ǘȅƳ ǿ Ƨŀƪƛ ǎǇƻǎƽō Ƴƻȍƴŀ ǇƻōǊŀŏ ŘŀƴŜΦ 

bŀƧǇǊƻǏŎƛŜƧ ǎƪƻǊȊȅǎǘŀŏ Ȋ ƭƛƴƪǳ ǇƻŘŀƴŜƎƻ ǿ ƻǇŎƧƛ αнύ ¦ǎƛƴƎ ŀ ōǊƻǿǎŜǊέΦ  
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5ŀƴŜ ǎǇŀƪƻǿŀƴŜ ǎŊ Řƻ Ǉƭƛƪǳ ¢!wΦ ² ǇǊȊȅǇŀŘƪǳ ȊŀƳƽǿƛŜƴƛŀ ǿƛťƪǎȊŜƧ ƭƛŎȊōȅ ǇǊƻŘǳƪǘƽǿ ŘŀƴŜ ƳƻƎŊ ōȅŏ 

ǎǇŀƪƻǿŀƴŜ Řƻ ƪƛƭƪǳ ǇƭƛƪƽǿΦ Uwaga !!! ŘŀƴŜ ŘƻǎǘťǇƴŜ ǎŊ ǇǊȊŜȊ т Řƴƛ ƻŘ ƛŎƘ ǇǊȊŜǘǿƻǊȊŜƴƛŀΦ ² ŎŜƭǳ ǇƻōǊŀƴƛŀ Ǉƭƛƪǳ 

ƴŀƭŜȍȅ ƪƭƛƪƴŊŏ ƴŀ ƧŜƎƻ ƴŀȊǿƛŜΣ ŀ ƴŀǎǘťǇƴƛŜ ǿȅōǊŀŏ ƻǇŎƧť Zapisz plik i folder docelowy.  

² ŎŜƭǳ ǊƻȊǇŀƪƻǿŀƴƛŀ ŀǊŎƘƛǿǳƳ Ƴƻȍƴŀ ǎƪƻǊȊȅǎǘŀŏ ƴǇΦ  Ȋ ŘŀǊƳƻǿŜƎƻ ǇǊƻƎǊŀƳǳ т½ƛǇΦ  

 

 

STRUKTURA DANYCH SENTINEL-3 / SLSTR 

Po pobraniu danych z serwisu CODA lub Eumetsat Data Centre, ƴŀƭŜȍȅ ǊƻȊǇŀƪƻǿŀŏ ƛŎƘ ȊŀǿŀǊǘƻǏŏ ȊŀŎƘƻǿǳƧŊŎ 

ƻǊȅƎƛƴŀƭƴŊ ƴŀȊǿť ǎǇŀƪƻǿŀƴȅŎƘ ŦƻƭŘŜǊƽǿΦ 5ƭŀ ǇƻōǊŀƴȅŎƘ ǇǊȊȅƪƱŀŘƻǿȅŎƘ ǇǊƻŘǳƪǘƽǿ ōťŘŊ ǘƻΥ 

¶ S3A_SL_2_WST____20200614T193628_20200614T211728_20200616T061947_6059_059_227______

MAR_O_NT_003.SEN3 (produkt pobrany z serwisu CODA) 

¶ S3B_SL_2_WST____20200614T085105_20200614T103205_20200615T195433_6059_040_078______

MAR_O_NT_003.SEN3 (produkt dostarczony przez Eumetsat Data Centre) 

² ƴŀȊǿƛŜ ŦƻƭŘŜǊƽǿ ǊƻȊǇŀƪƻǿŀƴȅŎƘ Ȋ Ǉƭƛƪƽǿ ȊŀƪƻŘƻǿŀƴŜ ǎŊ ƛƴŦƻǊƳŀŎƧŜ ƻ ǇǊƻŘǳƪŎƛŜΥ 

¶ S3A / S3B ς {ŀǘŜƭƛǘŀΣ ƪǘƽǊȅ ŘƻǎǘŀǊŎȊȅƱ ŘŀƴȅŎƘ ς ǿ ǇǊȊȅƪƱŀŘȊƛŜ rejestracja wieczorna z Senitnel-3A, 

rejestracja poranna z Senitnel-3B; 

¶ SL ς Sensor SLSTR 

¶ 2 - poziom przetworzenia L2 

¶ WST ς produkty termalne dla oōǎȊŀǊƽǿ ǿƻŘƴȅŎƘ (water surface temparature) 

¶ 20200614T193628 / 20200614T085105 ς ŎȊŀǎ ǇƻŎȊŊǘƪǳ ǊŜƧŜǎǘǊŀŎƧƛ granuli (pierwsza linia) ς 14 czerwca 

2020 roku godzina 19:36:28 / 08:51:05 

¶ 20200614T211728 / 20200614T103205 ς ŎȊŀǎ ƪƻƵŎŀ ǊŜƧŜǎǘǊŀŎƧƛ granuli (ostatnia linia) ς 14 czerwca 2020 

roku godzina 21:17:28/ 10:32:05 

¶ 20200616T061947 /  20200615T195433ς czas utworzenia produktu ς 16 czerwca 2020 roku godzina 

06:19:47/ 15 czerwca 2020 roku godzina 19:54:33  

¶ 6059 ς ŎȊŀǎ ǊŜƧŜǎǘǊŀŎƧƛ ŎŀƱŜƧ ǎŎŜƴȅ ǿ sekundach 

¶ 059 / 040 ς nr cyklu 

¶ 227 / 078 ς nr ǏŎƛŜȍƪƛ όƴǳƳŜǊ ƻǊōƛǘȅ ǿ cyklu) 

¶ _____ ς ƴǊ ƎǊŀƴǳƭƛ ǿȊŘƱǳȍ ǏŎƛŜȍƪƛΣ ōǊŀƪ ƴǳƳŜǊǳ ƻȊƴŀŎȊŀ ŎŀƱŊ ǏŎƛŜȍƪť 

¶ MAR (Marine Processing and Archiving Centre) ς ƻǏǊƻŘŜƪ ǇǊȊŜǘǿŀǊȊŀƧŊŎȅ ŘŀƴŜ 

¶ O ς ŦŀȊŀ ƻǇŜǊŀŎȅƧƴŀ ŘȊƛŀƱŀƴƛŀ ǎatelity (R ς w przypadku reprocessingu danych) 

¶ NT ς tryb: non time critical 

¶ 003 ς nr wersji przetwarzania (baseline collection) 

{ǘǊǳƪǘǳǊŀ ŦƻƭŘŜǊƽǿ ƧŜǎǘ taka sama, ƴƛŜȊŀƭŜȍƴƛŜ ƻŘ ǎŜǊǿƛǎǳΣ Ȋ ƪǘƽǊŜƎƻ ŘŀƴŜ ȊƻǎǘŀƱȅ ǇƻȊȅǎƪŀƴŜΦ ½ŀǿƛŜǊŀƧŊ ƻƴŜΥ 

¶ tƭƛƪ αxfdumanifest.xmlέ ȊŀǿƛŜǊŀƧŊŎȅ ƳŜǘŀŘŀƴŜ ƛ ƻǇƛǎ ǎǘǊǳƪǘǳǊȅ ǇǊƻŘǳƪǘƽǿ 

¶ Plik z danymi rastrowymi w formacie netCDF (*.nc)Σ ȊŀǿƛŜǊŀƧŊŎȅ ŘŀƴŜ  
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Zestaw danych produktu SL_2_WST όȊŀǿŀǊǘƻǏŏ Ǉƭƛƪǳ ƴŎύΥ 

¶ ǿǎǇƽƱǊȊťŘƴŜ ǇƛƪǎŜƭƛ όlat, lon)  

¶ temperatura powierzchni morza (skin temperature) wyznaczana najlepszym algorytmem 

(sea_surface_temperature) 

¶ ǎǘŀǘȅǎǘȅƪƛ ōƱťŘƽǿ όSingle Sensor Error Statistic): ǏǊŜŘƴƛ i odchylenie standardowe (sses_bias, 

sses_standard_deviation) 

¶ ǊƽȍƴƛŎŀ aktualnej ǿŀǊǘƻǏŎƛ {{¢ ǿ ǇƛƪǎŜƭǳ ƛ ƻǎǘŀǘƴƛŜƧ ǿŀǊǘƻǏŎƛ ǊŜŦŜǊŜƴŎȅƧƴŜgo produktu OSTIA L4 SST 

analysis (dt_analysis) 

¶ czas rejestracji piksela w sekundach (sst_dtime) od czasu referencyjnego sceny (time) podanego w 

metadanych (time+sst_dtime = czas rejestracji piksela w sekundach od 01.01.1981 00:00:00) 

¶ ŦƭŀƎƛ ƧŀƪƻǏŎƛ ŘŀƴȅŎƘ όl2p_flags, quality_level) 

¶ ŘƻŘŀǘƪƻǿŜ ǇŀǊŀƳŜǘǊȅ ǇǊȊȅŘŀǘƴŜ ǿ ƛƴǘŜǊǇǊŜǘŀŎƧƛ ǿŀǊǘƻǏŎƛ {{¢ z modelu ECMWFΥ ǇǊťŘƪƻǏŏ ǿƛŀǘru na 

ǿȅǎƻƪƻǏŎƛ мл Ƴ όwind_speed), procentowe pokrycie piksela lodem (sea_ice_fraction) oraz indeks 

ǿǇƱȅǿǳ ŀŜǊƻȊƻƭƛ ƴŀ ǎȅgƴŀƱ ǿ ǇƛƪǎŜƭǳ ƻǇŀǊǘȅ ƴŀ ŘŜŦƛƴƛŎji AATSR Saharan Dust Index 

(aerosol_dynamic_indicator) i ich ǊƽȍƴƛŎŀ ǿ ŎȊŀǎƛŜ w stosunku do danych satelitarnych 

(wind_speed_dtime_from_sst, sea_ice_fraction_dtime_from_sst, adi_dtime_from_sst) 

¶ temperatura radiacyjna ƴŀ ƎƽǊƴŜƧ ƎǊŀƴƛŎȅ ŀǘƳƻǎŦŜǊȅ ƻǊŀȊ ǘŜƳǇŜǊŀǘǳǊƻǿȅ ŜƪǿƛǿŀƭŜƴǘ ǎȊǳƳǳ 

w 3 ƪŀƴŀƱŀŎƘ ǎǇŜƪǘǊŀƭƴȅŎƘΥ {тΣ S8, S9 (brightness_temperature, nedt) 

¶ ŀƭƎƻǊȅǘƳ ǿȅƪƻǊȊȅǎǘŀƴȅ Řƻ ƻōƭƛŎȊŜƴƛŀ {{¢ ǿ ƪŀȍŘȅƳ ǇƛƪǎŜƭǳ όsst_algorithm_type) 

¶ ǊƽȍƴƛŎŀ ǿŀǊǘƻǏŎƛ {{¢ ƻōƭƛŎȊƻƴȅŎƘ ƴŀ ǇƻŘǎǘŀǿƛŜ ƻōǳ ǎǇƻƧǊȊŜƵ ƛ ǘȅƭƪƻ ƴŀŘƛǊƻǿŜƎƻ Řƭŀ ǇƛƪǎŜƭƛ ǿ ŎȊťǏŎƛ 

ǏŎƛŜȍƪƛ ǎƪŀƴƻǿŀƴŜƧ ǇƻŘǿƽƧƴƛŜ όdual_nadir_sst_difference) 

¶ ǘŜƻǊŜǘȅŎȊƴŜ ƴƛŜǇŜǿƴƻǏŎƛ όsst_theoretical_uncertainty, nadir_sst_theoretical_uncertainty) 

¶ prawdopodobƛŜƵǎǘǿƻ ǇƻƪǊȅŎƛŀ ŎƘƳǳǊŀƳƛ ǇƛƪǎŜƭŀ (Bayesian cloud detection algorithm) dla obu 

ǎǇƻƧǊȊŜƵΥ ƴŀŘƛǊƻǿŜƎƻ ƛ ǳƪƻǏƴŜƎƻ όprobability_cloud_single_in, probability_cloud_single_io) 

¶ ƪŊǘ ȊŜƴƛǘŀƭƴȅ ǎŀǘŜƭƛǘȅ ǿ ƳƻƳŜƴŎƛŜ ǊŜƧŜǎǘǊŀŎƧƛ ǇƛƪǎŜƭŀ όsatellite_zenith_angle) 

²ǎȊȅǎǘƪƛŜ ǿŀǊǘƻǏŎƛ ǘŜƳǇŜǊŀǘǳǊȅ ǎŊ ǿ YŜƭǾƛƴŀŎƘΦ Dane oznaczone kolorem zielonym ǳŘƻǎǘťǇƴƛŀƴŜ ǎŊ ƴŀ ǊŀȊƛŜ 

eksperymentalnie.  

²ƛťŎŜƧ ƛƴŦƻǊƳŀŎƧƛ ƴŀ ǘŜƳŀǘ ŀƭƎƻǊȅǘƳƽǿ ǇǊȊŜǘǿŀǊȊŀƴƛŀ ŘŀƴȅŎƘ {[{¢w ƛ ƛŎƘ ǇǊƻŘǳƪǘƽǿ w serwisie Sentinel Online 

  

https://earth.esa.int/web/sentinel/technical-guides/sentinel-3-slstr
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²{¢Btb9 tw½9¢²!w½!bL9 5!b¸/I ² twhDw!aL9 SNAP 

Do dalszej ŎȊťǏŎƛ ŏǿƛŎȊŜƵ ǿȅƪƻǊȊȅǎǘŀƴŜ ōťŘȊƛŜ ōŜȊǇƱŀǘƴŜ oprogramowanie SNAP. aƻȍƭƛǿƻǏŏ pobrania 

oprogramowania na stronie http://step.esa.int/main/download/snap-download/. Do przeprowadzenia 

ȊŀǇǊŜȊŜƴǘƻǿŀƴȅŎƘ ǘǳ ŀƴŀƭƛȊ ǿȅǎǘŀǊŎȊȅ Ȋŀƛƴǎǘŀƭƻǿŀŏ ǇŀƪƛŜǘ ƴŀǊȊťŘȊƛ Řƭŀ ǎŀǘŜƭƛǘƽǿ {Ŝƴǘƛƴel (Sentinel Toolboxes). 

Na stronie http://step.esa.int/main/doc/tutorials/ ȊƴŀƧŘǳƧŊ ǎƛť ƪǊƽǘƪƛŜ ǘǳǘƻǊƛŀƭŜ ƻƳŀǿƛŀƧŊŎŜ ǇƻŘǎǘŀǿƻǿŜ 

funkcje programu. tƻ ǳǊǳŎƘƻƳƛŜƴƛǳ ǇǊƻƎǊŀƳǳ ƎƱƽǿƴŜ ƻƪƴƻ ƻǊŀȊ ȊŀǿŀǊǘƻǏŏ ƳŜƴǳ ƛ Ǉŀǎƪŀ ƴŀǊȊťŘȊƛ ƳƻȍŜ 

ǿȅƎƭŊŘŀŏ ǊƽȍƴƛŜΣ ǿ ȊŀƭŜȍƴƻǏŎƛ ƻŘ ȊŀƛƴǎǘŀƭƻǿŀƴŜƎƻ ȊŜǎǘŀǿǳ ǘƻƭƭōƻȄƽǿΦ ² ǇǊȊȅǇŀŘƪǳΣ ƎŘȅ ƧŀƪƛŜǏ ƻƪƴƻ ƴŀǊȊťŘȊƛ 

ǿȅƪƻǊȊȅǎǘȅǿŀƴȅŎƘ ǿ ŏǿƛŎȊŜƴƛǳ ƴƛŜ ƧŜǎǘ ǿƛŘƻŎȊƴŜ Ƴƻȍƴŀ ƧŜ ƻǘǿƻǊȊȅŏ Ȋŀ ǇƻƳƻŎŊ ǇƻƭŜŎŜƴƛŀ View > Tool windows. 

²¸|²L9¢[!bL9 5!b¸/H 

!ōȅ ǿŎȊȅǘŀŏ ŘŀƴŜ ǎŀǘŜƭƛǘŀǊƴŜ ƴŀƭŜȍȅ ǿȅōǊŀŏ ǇƻƭŜŎŜƴƛŜ File > Open ProductΣ ƴŀǎǘťǇƴƛŜ ǿ ƻƪƴƛŜ ŘƛŀƭƻƎƻǿȅƳ 

ǇǊȊŜƧǏŏ Řƻ ŦƻƭŘŜǊǳΣ Řƻ ƪǘƽǊŜƎƻ ŘŀƴŜ ȊƻǎǘŀƱȅ ǊƻȊǇŀƪƻǿŀƴŜ, ǿǎƪŀȊŀŏ Ǉƭƛƪ xfdumanifest.xml ƛ ƪƭƛƪƴŊŏ Open.  

Uwaga!!! Podczas rozpakowywania danych Sentinel-о ƴŀƭŜȍȅ ȊŀŎƘƻǿŀŏ ƻǊȅƎƛƴŀƭƴŊ ƴŀȊǿť ŦƻƭŘŜǊǳΦ Dla 

ŀƴŀƭƛȊƻǿŀƴŜƎƻ ǇǊȊȅƪƱŀŘǳ όŘŀƴŜ Ȋ ǎŜǊǿƛǎǳ /h5!ύ ƧŜǎǘ ǘƻΥ 

S3A_SL_2_WST____20200614T193628_20200614T211728_20200616T061947_6059_059_227______MAR_O_

NT_003.SEN3  

 

Program SNAP automatycznie wczyta plik *.nc zawarty ǿ ŦƻƭŘŜǊȊŜ ǇǊƻŘǳƪǘǳΦ {ǘǊǳƪǘǳǊť ǇǊƻŘǳƪǘǳ ƳƻȍŜƳȅ 

ǇƻŘŜƧǊȊŜŏ ǿ ƻƪƴƛŜ Product Explorer (otwarty ǇǊȊŜǿŀȍƴƛŜ ǿ ƭŜǿŜƧ ƎƽǊƴŜƧ ŎȊťǏŎƛ ƻƪƴŀ ǇǊƻƎǊŀƳǳ {b!t)Φ ½ŀǿŀǊǘƻǏŏ 

rozwija ǎƛť ǇǊȊŜȊ ƪƭƛƪƴƛťŎƛŜ ǿ Ȋƴŀƪ  Ǉƻ ƭŜǿŜƧ ǎǘǊƻƴƛŜ ƴŀȊǿȅ ǇǊƻŘǳƪǘǳ ƛ ƪŀȍŘŜƎƻ Ȋ ȊŀǿŀǊǘȅŎƘ ǿ ƴƛƳ ŦƻƭŘŜǊƽǿΦ 

tǊȊȅƪƱadowo: dane z ƪŀƴŀƱƽǿ ǎǇŜƪǘǊŀƭƴȅŎƘ IR όǿŀǊǘƻǏŎƛ temperatury radiacyjnej ƴŀ ƎƽǊƴŜƧ ƎǊŀƴƛŎȅ ŀǘƳƻǎŦŜǊȅ) dla 

spojrzenia nadirowego ȊƴŀƧŘǳƧŊ ǎƛť ǿ ŦƻƭŘŜǊȊŜ Bands > brightness_temperature (channel 1 = S7, channel 2 = S8, 

channel 3 = S9); wsǇƽƱǊȊťŘƴŜ ǇƛƪǎŜƭƛ ǿ ǿŀǊǎǘǿŀŎƘ ǊŀǎǘǊƻǿȅŎƘ lat i lon; ƻōƭƛŎȊƻƴŜ ǿŀǊǘƻǏŎƛ ǘŜƳǇŜǊŀǘǳǊȅ 

powierzchni morza w sea_surface_temperature. 

http://step.esa.int/main/download/snap-download/
http://step.esa.int/main/doc/tutorials/
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!ōȅ ǿȅǏǿƛŜǘƭƛŏ ŘŀƴŜ ǘŜƳǇŜǊŀǘǳǊȅ ƴŀƭŜȍȅ ŘǿǳƪǊƻǘƴƛŜ ƪƭƛƪƴŊŏ ǊŀǎǘŜǊ sea_surface_temperature. W oknie 

ǿȅǏǿƛŜǘƭŀƴƛŀ ȊƻǎǘŀƴƛŜ ǿȅǏǿƛŜǘƭƻƴȅ ǊŀǎǘŜǊ ǿ ƻŘŎƛŜƴƛŀŎƘ ǎȊŀǊƻǏŎƛΦ 5ŀƴŜ {[ψнψ²{¢ ǿ ǘǊȅōƛŜ b¢/ ŎȊťǎǘƻ ǎŊ 

ǳŘƻǎǘťǇƴƛŀƴŜ Řƭŀ ŎŀƱŜƧ ǏŎƛŜȍƪƛΣ ŀ ƴƛŜ Řƭŀ ǿȅōǊŀƴȅŎƘ ƎǊŀƴǳƭΣ ǘŀƪ Ƨŀƪ ǘƻ ƧŜǎǘ ǿ ǇǊȊȅƪƱŀŘȊƛŜΦ {ǘŊŘ ōŀǊŘȊƻ ǿŊǎƪƛ ƛ ŘƱǳƎƛ 

raster (1500 kolumn ³ плофп ǿƛŜǊǎȊȅύΦ tǊȊŜōƛŜƎ ǏŎƛŜȍƪƛ Ƴƻȍƴŀ ǇǊȊŜǏƭŜŘȊƛŏ ǿ ƻƪƴƛŜ World View (zwykle jedna 

z ȊŀƪƱŀŘŜƪ ǿ ƻƪƴƛŜ ǇƻƴƛȍŜƧ Product Explorer). .ŀƱǘȅƪ ȊƴŀƧŘǳƧŜ ǎƛť ƴƛŜŎƻ ǇƻǿȅȍŜƧ ǏǊƻŘƪŀ ǏŎƛŜȍƪƛΦ tǊȊȅōƭƛȍ ǘŜƴ ƻōǎȊŀǊ 

ƪƻǊȊȅǎǘŀƧŊŎ Ȋ ƴŀǊȊťŘȊƛ Zooming Tool  i Pan Tool  Ȋ Ǉŀǎƪŀ ƴŀǊȊťŘȊƛ Tools. hōǎȊŀǊ 9ǳǊƻǇȅ ǊŜƧŜǎǘǊƻǿŀƴȅ ōȅƱ 

ǇƻŘŎȊŀǎ ƭƻǘǳ ǎŀǘŜƭƛǘȅ Ȋ ǇƻƱǳŘƴƛŀ ƴŀ ǇƽƱƴƻŎΣ ǎǘŊŘ ƻŘǿǊƽŎƻƴȅ ƻōǊŀȊ όƻōǊŀȊ ǿȅǏǿƛŜǘƭŀƴȅ ƧŜǎǘ ƻŘ ƎƽǊȅ ς pierwsza 

ƭƛƴƛŀΣ ǿ ŘƽƱ ς ƻǎǘŀǘƴƛŀ ƭƛƴƛŀύΦ ² ƻƪƴƛŜ bŀǾƛƎŀǘƛƻƴ Ƴƻȍƴŀ ƻōǊƽŎƛŏ ƻōǊŀȊ ǇƻŘŀƧŊŎ ƪŊǘ ƻōǊƻǘǳ мулϲΦ 
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tƻǊǳǎȊŀƧŊŎ ǎƛť ƪǳǊǎƻǊŜƳ ǿ ƻƪƴƛŜ ǿȅǏǿƛŜǘƭŀƴƛŀ ƴŀ Ǉŀǎƪǳ ǎǘŀƴǳ ǳ ŘƻƱǳ ƻƪƴŀ moȍƴŀ ǇƻŘŜƧǊȊŜŏ ǿǎǇƽƱǊȊťŘƴŜ 

ƎŜƻƎǊŀŦƛŎȊƴŜ ǿǎƪŀȊȅǿŀƴȅŎƘ ǇƛƪǎŜƭƛ ƭǳō ǿǎǇƽƱǊȊťŘƴŜ ǊŀǎǘǊƻǿŜ ό· - nr kolumny, Y ς nr linii). hōǎȊŀǊ .ŀƱǘȅƪǳ ƳƛŜǏŎƛ 

ǎƛť ƳƴƛŜƧ ǿƛťŎŜƧ ǇƻƳƛťŘȊȅ ƭƛƴƛŀƳƛΥ м5500 ς 18000.  

 

W oknie Pixel Info ƻǇǊƽŎȊ ǇƻȊȅŎƧƛ ǿǎƪŀȊȅǿŀƴŜƎƻ ǇƛƪǎŜƭŀ Ƴƻȍƴŀ ǇƻŘŜƧǊȊŜŏ ǊƽǿƴƛŜȍ ǿŀǊǘƻǏŏ ǇƛƪǎŜƭŀΣ ǘǳ 

ǘŜƳǇŜǊŀǘǳǊť ǇƻǿƛŜǊȊŎƘƴƛ ƳƻǊȊŀ ǿ YŜƭǾƛƴŀŎƘ ƻǊŀȊ ǊƻȊƪƻŘƻǿŀƴŜ ǿŀǊǘƻǏŎƛ ŦƭŀƎ όǘǊǳŜ κ ŦŀƭǎŜ dla ǊƽȍƴȅŎƘ ǎǘŀƴƽǿύ. 

Dane SL_2_WST ǿ ƻōǎȊŀǊȊŜ ƭŊŘǳ ƳŀƧŊ ǿŀǊǘƻǏŎƛ ƪƻŘƻǿŀƴŜ Ƨŀƪƻ αōǊŀƪ ŘŀƴȅŎƘέΦ tƛƪǎŜƭŜ ƭŊŘƻǿŜ ǿȅǏǿƛŜǘƭŀƴŜ ǎŊ 

ƪƻƭƻǊŜƳ ǘƱŀ ƻƪƴŀΣ ŀ ǿŀǊǘƻǏŏ ǇƻŘŀǿŀƴŀ ƧŜǎǘ Ƨŀƪƻ bŀbΦ tƻŘƻōƴƛŜ αƳŀǎƪƻǿŀƴŜέ ǎŊ ƛƴƴŜ ƻōǎȊŀǊȅΣ ƎŘȊƛŜ ƴƛŜ Ƴƻȍƴŀ 

ƻōƭƛŎȊȅŏ ǿŀǊǘƻǏŎƛ {{¢Φ ² ƻƪƴƛŜ Colour Manipulation ǿƛŘƻŎȊƴȅ ƧŜǎǘ ƘƛǎǘƻƎǊŀƳ ǿŀǊǘƻǏŎƛ {{T oraz podstawowe 

ǎǘŀǘȅǎǘȅƪƛΣ ƻōƭƛŎȊŀƴŜ Řƭŀ ŎŀƱŜƎƻ ǊŀǎǘǊŀΣ Ȋ ǇƻƳƛƴƛťŎƛŜƳ ǿŀǊǘƻǏŎƛ bŀbΦ !ōȅ ǳȊȅǎƪŀŏ ǿŀǊǘƻǏŎƛ Řƭŀ ǿȅōǊŀƴŜƎƻ 

ǇƻŘƻōǎȊŀǊǳ ƴŀƭŜȍȅ ǳǘǿƻǊȊȅŏ subsetΣ ŎȊȅƭƛ ǇƻŘȊōƛƽǊ ȊŀǿƛŜǊŀƧŊŎȅ ǘȅƭƪƻ ŎȊťǏŏ ƻǊȅƎƛƴŀƭƴȅŎƘ ŘŀƴȅŎƘ. 

 

²ŀǊǘƻǏŏ ǘŜƳǇŜǊŀǘǳǊȅ ǿ YŜƭǾƛƴŀŎƘ ǇƻŘŀǿŀƴŀ ƧŜǎǘ Ȋ ŘƻƪƱŀŘƴƻǏŎƛŊ Řƻ лΣлмYΦ ² ŎŜƭǳ ȊƳƴƛŜƧǎȊŜƴƛŀ ǊƻȊƳƛŀǊǳ Ǉƭƛƪƽǿ 

ŘŀƴŜ ȊŀǇƛǎŀƴŜ ǎŊ Ƨŀƪƻ ǿŀǊǘƻǏŎƛ ŎŀƱƪƻǿƛǘŜ όw!²ύΦ tǊƻƎǊŀƳ {b!t ǿ ǎǇƻǎƽō ŘȅƴŀƳƛŎȊƴȅ ƪƻƴǿŜǊǘǳƧŜ ƧŜ Řƻ ǿƛŜƭƪƻǏŎƛ 

ƎŜƻŦƛȊȅŎȊƴȅŎƘ όǘǳ {{¢ύ ȊƎƻŘƴƛŜ Ȋ ŦƻǊƳǳƱŊΥ 

ὛὛὝὪὥὧὸέὶϽὙὃὡ έὪὪίὩὸ 
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Zastosowanie innego oprogramowania do czytania i analizy danych SL_2_WST ƳƻȍŜ ǿȅƳŀƎŀŏ ǎŀƳƻŘȊƛŜƭƴŜƎƻ 

ǇǊȊŜƭƛŎȊŜƴƛŀ ǿŀǊǘƻǏŎƛ w!²Φ Scaling factor i offset Ƴƻȍƴŀ ƻŘŎȊȅǘŀŏ Ȋŀ ǇƻƳƻŎŊ ŦǳƴƪŎƧƛ Analysis > Information. 

 

 

PRZYGOTOWANIE MAPY SST 

² ŎŜƭǳ ǇǊȊȅƎƻǘƻǿŀƴƛŀ ƳŀǇȅ ǘŜƳǇŜǊŀǘǳǊȅ ǇƻǿƛŜǊȊŎƘƴƛ ƳƻǊȊŀ ƴŀƭŜȍȅ Řƻƪƻƴŀŏ ǇǊƻƧŜƪŎƧƛ ŘŀƴȅŎƘ Řƻ ƻŘǿȊƻǊƻǿŀƴƛŀ 

ƪŀǊǘƻƎǊŀŦƛŎȊƴŜƎƻΦ !ōȅ ǎƪǊƽŎƛŏ ƻōƭƛŎȊŜƴƛŀ Ƴƻȍƴŀ ǿŎȊŜǏƴƛŜƧ ƻƎǊŀƴƛŎȊȅŏ ŘŀƴŜ Řƻ ƻōǎȊŀǊǳ ƻōŜƧƳǳƧŊŎŜƎƻ .ŀƱǘȅƪ 

ǘǿƻǊȊŊŎ subset.  W ŘŀƭǎȊȅŎƘ ƪǊƻƪŀŎƘ Ƴƻȍƴŀ ǿȅƪƻǊȊȅǎǘŀŏ ŦƭŀƎƛ Řƻ ǿȅƳŀǎƪƻǿŀƴƛŀ ǇƛƪǎŜƭƛ ȊŀŎƘƳǳǊȊƻƴȅŎƘ ƭǳō ǘȅŎƘ 

ƻ ƴƛǎƪƛŜƧ ƧŀƪƻǏŎƛ ŘŀƴȅŎƘ ƻǊŀȊ ǇǊȊŜƭƛŎȊȅŏ ǿŀǊǘƻǏŎƛ ǘŜƳǇŜǊŀǘǳǊȅ Řƻ ϲ/Φ ¢ŀƪ ǇǊȊȅƎƻǘƻǿŀƴŜ ŘŀƴŜ Ƴƻȍƴŀ 

ǿȅŜƪǎǇƻǊǘƻǿŀŏ Řƻ ŘŀƭǎȊŜƧ ǇǊŀŎȅ ǿ DL{ ƭǳō Ȋŀǎǘƻǎƻǿŀŏ ƻŘǇƻǿƛŜŘƴƛŊ ǇŀƭŜǘť ōŀǊǿ ƛ ȊŀǇƛǎŀŏ Ƨŀƪƻ ƻōǊŀȊ Řƻ 

wykorzystania w prezentacji. 

WYCINANIE PODOBSZARU 

5ƻ ǳǘǿƻǊȊŜƴƛŀ ǇƻŘȊōƛƻǊǳΣ ȊŀǿƛŜǊŀƧŊŎŜƎƻ ǘȅƭƪƻ ŎȊťǏŏ ƻǊȅƎƛƴŀƭƴȅŎƘ ŘŀƴȅŎƘ όǘǳ wszystkie dane ograniczone do 

obszaru ƻōŜƧƳǳƧŊŎŜƎƻ .ŀƱǘȅƪύ ǿ ǇǊƻƎǊŀƳƛŜ {b!t ǎƱǳȍȅ ŦǳƴƪŎƧŀ Raster > SubsetΦ  tƻȊǿŀƭŀ ƻƴŀ ǳǘǿƻǊȊȅŏ ǇƻŘȊōƛƽǊ 

ȊŀǊƽǿƴƻ ȊŀǿťȍŀƧŊŎ ƻōǎȊŀǊ όSpatial SubsetύΣ Ƨŀƪ ƛ ȊŀǿŀǊǘƻǏŏ ȊōƛƻǊǳ ŘŀƴȅŎƘΥ  

¶ ǎǇŜƪǘǊŀƭƴȅŎƘ ƛ ǿȅȊƴŀŎȊƻƴȅŎƘ ƴŀ ƛŎƘ ǇƻŘǎǘŀǿƛŜ ǇŀǊŀƳŜǘǊƽǿ ƎŜƻŦƛȊȅŎȊƴȅŎƘΣ ŘŀƴȅŎƘ ƎŜƻƭƻƪŀŎƧƛΣ ŦƭŀƎΣ 

masek (Band subset) 

¶ dodatkowych danych (auxiliary dataύΣ ƪǘƽǊŜ ƳƻƎŊ ōȅŏ ǿȅƪƻǊȊȅǎǘŀƴŜ Řƻ ŘŀƭǎȊȅŎƘ ƪƻǊŜƪŎƧƛ ƛ ƛƴǘŜǊǇǊŜǘŀŎƧƛ 

(Tie-Point Grid Subset) 

¶ metadanych (Metadata Subset) 

hƎǊŀƴƛŎȊŜƴƛŜ ǇǊȊŜǎǘǊȊŜƴƴŜ ȊōƛƻǊǳ ŘŀƴȅŎƘ ƳƻȍŜ ƻŘōȅǿŀŏ ǎƛť ǇƻǇǊȊŜȊ ȊŀŘŀƴƛŜ ȊŀƪǊŜǎǳ ƭƛƴƛƛ ƛ ƪƻƭǳƳƴ όȊŀƪƱŀŘƪŀ Pixel 

Coordinates) lub wǎǇƽƱǊȊťŘƴȅŎƘ ƎŜƻƎǊŀŦƛŎȊƴȅŎƘ όȊŀƪƱŀŘƪŀ Geo Coordinates). 

hƎǊŀƴƛŎȊ ȊōƛƽǊ ŘŀƴȅŎƘ ǇǊȊŜǎǘǊȊŜƴƴƛŜ do linii (Y) 15500 ς 17999. Pozostaw wszystkie dane rastrowe (Band), dane 

dodatkowe (Tie-Point Grid) oraz metadane. 
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W oknie Product Explorer powstanƛŜ ƪƻƭŜƧƴȅ ǇǊƻŘǳƪǘ ȊŀǿƛŜǊŀƧŊŎȅ 

ǿȅōǊŀƴȅ ǇƻŘȊōƛƽǊ ŘŀƴȅŎƘΦ ²ƱŀǏŎƛǿƛŜ ƧŜǎǘ ǘƻ ǇǊƻŘǳƪǘ ǿƛǊǘǳŀƭƴȅΣ 

ȊŀǿƛŜǊŀƧŊŎȅ ǘȅƭƪƻ ƻŘǇƻǿƛŜŘƴƛŜ ŘŜŦƛƴƛŎƧŜΣ ƪǘƽǊȅŎƘ ǳǊǳŎƘƻƳƛŜƴƛŜ 

ǇƻǿƻŘǳƧŜ ǿŎȊȅǘŀƴƛŜ ƻƪǊŜǏƭƻƴȅŎƘ ŘŀƴȅŎƘ Ȋ ǇǊƻŘǳƪǘǳ ƻǊȅƎƛƴŀƭƴŜƎƻΦ  

Dlatego orygiƴŀƭƴȅ ǇǊƻŘǳƪǘ Ƴǳǎƛ ǇƻȊƻǎǘŀǿŀŏ ƴŀŘŀƭ ƻǘǿŀǊǘȅ 

w Product Explorer. ½ŀƳƪƴƛƧ ǿȅǏǿƛŜǘƭŀƴȅ ǊŀǎǘŜǊ 

sea_surface_temperature ƛ ƻǘǿƽǊȊ Ǝƻ ǇƻƴƻǿƴƛŜΣ ŀƭŜ ƪƻǊȊȅǎǘŀƧŊŎ 

z ƴƻǿŜƎƻ ǇǊƻŘǳƪǘǳ όǎǳōǎŜǘψмψϝύΣ ƻōǊƽŏ ƻōǊŀȊ ƻ мулϲΦ  ½ŀǳǿŀȍΣ ȍŜ 

w oknie Colour Manipulation ȊƳƛŜƴƛƱ ǎƛť ƪǎȊǘŀƱǘ ƘƛǎǘƻƎǊŀƳǳ ǿŀǊǘƻǏŎƛ 

SST i statystyki.  

 

WŜȍŜƭƛ ƴƛŜ ƧŜǎǘ ƪƻƴƛŜŎȊƴŜ ǇǊȊŜŘǎǘŀǿƛŀƴƛŜ ŘŀƴȅŎƘ ǿ ǇƻǎǘŀŎƛ ƳŀǇȅ ǿ ƻŘǇƻǿƛŜŘƴƛƳ ƻŘǿȊƻǊƻǿŀƴƛǳ Ƴƻȍƴŀ ōŀǊŘȊƛŜƧ 

ȊŀǿťȊƛŏ ƻōǎȊŀǊ ŘŀƴȅŎƘ ƛ ǇƻƳƛƴŊŏ ƪƻƭŜƧƴȅ ƪǊƻƪ όǇǊƻƧŜƪŎƧťύ ǇǊȊŜŎƘƻŘȊŊŎ ƻŘ ǊŀȊǳ do maskowania pikseli. Aby wyniki 

ƪƻƭŜƧƴȅŎƘ ƻǇŜǊŀŎƧƛ ȊƻǎǘŀƱȅ ȊŀǇƛǎŀƴŜ ƴŀ ŘȅǎƪǳΣ ǿŀǊǘƻ ȊŀǇƛǎŀŏ ǿŎȊŜǏƴƛŜƧ subset w formacie BEAM-DIMAP za 

ǇƻƳƻŎŊ ƻǇŎƧƛ File > Save ProductΦ ½ŀƳƪƴŊŏ ƻōŀ ǇǊƻŘǳƪǘȅ ǿ ƻƪƴƛŜ Product ExplorerΣ ŀ ƴŀǎǘťǇƴƛŜ ƻǘǿƻǊȊȅŏ Ȋ dysku 

produkt zapisany w formacie BEAM-DIMAP. !ōȅ ȊŀƳƪƴŊŏ ŀƴŀƭƛȊƻǿŀƴȅ ǇǊƻŘǳƪǘ ǿ ǇǊƻƎǊŀƳƛŜ {b!t ƴŀƭŜȍȅ ƪƭƛƪƴŊŏ 

prawym klawiszem myszy na jego nazwie w oknie Product ExplorerΣ ŀ ƴŀǎǘťǇƴƛŜ ǿȅōǊŀŏ ƻǇŎƧť Close Product. Aby 

ƻǘǿƻǊȊȅŏ ǇǊƻŘǳƪǘ ǿ ŦƻǊƳŀŎƛŜ .9!a-5La!t ƴŀƭŜȍȅ ǿȅōǊŀŏ File > Open ProductΣ ƴŀǎǘťǇƴƛŜ ǿ ƻƪƴƛŜ ŘƛŀƭƻƎƻǿȅƳ 

ǇǊȊŜƧǏŏ Řƻ ŦƻƭŘŜǊǳΣ Řƻ ƪǘƽǊŜƎƻ ŘŀƴŜ ȊƻǎǘŀƱȅ ȊŀǇƛǎŀƴŜΣ ǿǎƪŀȊŀŏ Ǉƭƛƪ NazwaProduktu.dim ƛ ƪƭƛƪƴŊŏ Open. ǿƛťŎŜƧ ƴŀ 

temat formatu BEAM-DIMAP ǿ ƴŀǎǘťǇƴȅƳ podrozdziale. 
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PROJEKCJA DO ODWZOROWANIA KARTOGRAFICZNEGO 

YǎȊǘŀƱǘ ƛ ǇƻƱƻȍŜƴƛŜ .ŀƱǘȅƪǳ ƴŀ ƻōǊŀȊŀŎƘ {9b¢Lb9[-о ȊŀƭŜȍȅ ƻŘ ƪƛŜǊǳƴƪǳ ƭƻǘǳ ǎŀǘŜƭƛǘȅ όǏŎƛŜȍƪƛύΣ ȊŜ ǿȊƎƭťŘǳ ƴŀ to, ȍŜ 

ŘŀƴŜ ƴƛŜ ȊƻǎǘŀƱȅ ǇƻŘŘŀƴŜ ǇǊƻƧŜƪŎƧƛ Řƻ ȍŀŘƴŜƎƻ ƻŘǿȊƻǊƻǿŀƴƛŀΦ ¦ŘƻǎǘťǇƴƛŀƴŜ ǎŊ ǿ siatce instrumentalnej (po 

ƪƻǊŜƪŎƧƛ ȊƴƛŜƪǎȊǘŀƱŎŜƵ ƎŜƻƳŜǘǊȅŎȊƴȅŎƘ ǿȅƴƛƪŀƧŊŎȅŎƘ Ȋ ŎƘŀǊŀƪǘŜǊȅǎǘȅƪƛ ŎȊǳƧƴƛƪŀ)Φ ¦ǘǊǳŘƴƛŀ ǘƻ ǇƻǊƽǿƴȅǿŀƴƛŜ 

ƻōǊŀȊƽǿ ǊŜƧŜǎǘǊƻǿŀƴȅŎƘ ǿ ǊƽȍƴȅƳ ŎȊŀǎƛŜΣ ŘƭŀǘŜƎƻ ǇǊȊŜŘ ŘŀƭǎȊȅƳƛ ŜǘŀǇŀƳƛ ǿƛȊǳŀƭƛȊŀŎƧƛ ǿŀǊǘƻ ŘŀƴŜ ǇƻŘŘŀŏ 

projekcji. W programie SN!t ǎƱǳȍȅ Řƻ ǘŜƎƻ ŦǳƴƪŎƧŀ Raster > Geometric Operations > Reprojection. 

² ȊŀƪƱŀŘŎŜ I/O Parameters wybierz: 

¶ ǳǘǿƻǊȊƻƴȅ ǿŎȊŜǏƴƛŜƧ ǎǳōǎŜǘ Ƨŀƪƻ ǇǊƻŘǳƪǘ ǇƻŘŘŀǿŀƴȅ ǊŜǇǊƻƧŜƪŎƧƛ 

¶ ǇƻŘŀƧ ƴŀȊǿť ǇǊƻŘǳƪǘǳΣ ƪǘƽǊȅ ǇƻǿǎǘŀƴƛŜ Ǉƻ ǇǊƻƧŜƪŎƧƛ 

¶ wybierz zapis w formacie BEAM-DIMAP 

¶ pƻŘŀƧ ǏŎƛŜȍƪť Řƻ ŦƻƭŘŜǊǳΣ ǿ ƪǘƽǊȅƳ Ƴŀ Ȋƻǎǘŀŏ zapisany produkt po projekcji 

¶ ȊŀȊƴŀŎȊ ƻǇŎƧť Open in SNAP, aby progrŀƳ ǿŎȊȅǘŀƱ ŀǳǘƻƳŀǘȅŎȊƴƛŜ ŘŀƴŜ Ǉƻ ǇǊƻƧŜƪŎƧƛ 

   

CǳƴƪŎƧŀ ǊŜǇǊƻƧŜƪŎƧƛ ǇƻȊǿŀƭŀ ȊŀǇƛǎŀŏ ǿȅƴƛƪƻǿȅ ǇǊƻŘǳƪǘ ǿ ǊƽȍƴȅŎƘ ŦƻǊƳŀǘŀŎƘΦ CƻǊƳŀǘ .9!a-5La!t ƧŜǎǘ ǿȅƎƻŘƴŊ 

ŦƻǊƳŊ ȊŀǇƛǎǳ ǇƻŘŎȊŀǎ ǇǊŀŎȅ ǿ {b!tΣ ǇƻƴƛŜǿŀȍ ǇƻȊǿŀƭŀ ƴŀ ȊŀǇƛǎȅǿŀƴƛŜ ǿǊŀȊ Ȋ ŘŀƴȅƳƛ ǊƽǿƴƛŜȍ ǿȅōǊŀƴȅŎƘ ǇŀƭŜǘ 

ōŀǊǿƴȅŎƘ Řƻ ǿƛȊǳŀƭƛȊŀŎƧƛΣ ǳǎǘŀǿƛŜƵ ƪƻƴǘǊŀǎǘǳΣ ǿƱŀǏŎƛǿƻǏŎƛ ŘƻŘŀǿŀƴȅŎƘ ǇƛƴŜȊŜƪ ƛǘǇΦ 

² ȊŀƪƱŀŘŎŜ Reprojection Parameters ƴŀƭŜȍȅ ǿȅōǊŀŏ ƻŘǿȊƻǊƻǿŀƴƛŜ Řƻ ƧŀƪƛŜƎƻ ȊƻǎǘŀƴƛŜ ǇǊȊŜǇǊƻǿŀŘȊƻƴŀ 

ǇǊƻƧŜƪŎƧŀΣ ȊŘŜŦƛƴƛƻǿŀŏ ǎƛŀǘƪť ǊŀǎǘǊƻǿŊ ǿ ǿȅōǊŀƴȅƳ ƻŘǿȊƻǊƻǿŀƴƛǳ ƻǊŀȊ ǿȅōǊŀŏ ƳŜǘƻŘť ǊŜǎŀƳǇƭƛƴƎǳΦ 

²ȅōƽǊ ƻŘǿȊƻǊƻǿŀƴƛŀ ƳƻȍŜ ƻŘōȅǿŀŏ ǎƛť ƴŀ о ǎǇƻǎƻōȅΥ 

¶ ȊŘŜŦƛƴƛƻǿŀƴƛŜ ǿƱŀǎƴŜƎƻ ƻŘǿȊƻǊƻǿŀƴƛŀ όCustom CRSύ ǇǊȊŜȊ ǿȅōƽǊ 5!¢¦aΣ ǇǊƻƧŜƪŎƧƛ ƻǊŀȊ ȊŘŜŦƛƴƛƻǿŀƴƛŜ 

ǿƱŀǏŎƛǿȅŎƘ Řƭŀ ŘŀƴŜƧ ǇǊƻƧŜƪŎƧƛ ǇŀǊŀƳŜǘǊƽǿ 

¶ ǿȅōƽǊ ǎǇƻǏǊƽŘ ȊŘŜŦƛƴƛƻǿŀƴȅŎƘ ǇǊƻƧŜƪŎƧƛ όPredefined CRS) 

¶ ǿǎƪŀȊŀƴƛŜ ƛƴƴŜƎƻ ǇǊƻŘǳƪǘǳΣ ƪǘƽǊŜƎƻ ƻŘǿȊƻǊƻǿŀƴƛŜ Ƴŀ ǇƻǎƱǳȍȅŏ Ƨŀƪƻ ǿȊƻǊȊŜŎ όUse CRS of) 

Produkt poddawany reprojekcji 

Nazwa produktu wynikowego 

Format produktu wynikowego 

|ŎƛŜȍƪŀ Řƻ ŦƻƭŘŜǊǳΣ ǿ ƪǘƽǊȅƳ ȊƻǎǘŀƴƛŜ ȊŀǇƛǎŀƴȅ 
wynikowy produkt 
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½ŘŜŦƛƴƛƻǿŀƴƛŜ ǎƛŀǘƪƛ ǊŀǎǘǊƻǿŜƧ ǿ ǿȅōǊŀƴȅƳ ƻŘǿȊƻǊƻǿŀƴƛǳ ƳƻȍŜ ƻŘōȅǿŀŏ ǎƛť ƴŀ н ǎǇƻǎƻōȅΥ 

¶ automatycznie (zaznaczona opcja Preserve resolution) ς program dopasuje granice siatki tak aby 

ȊƳƛŜǏŎƛƱ ǎƛť ŎŀƱȅ ƻōǎȊŀǊ ŘŀƴȅŎƘ Ȋ ǇǊƻŘǳƪǘǳ ǿŜƧǏŎƛƻǿŜƎƻΣ ŀ ǿƛŜƭƪƻǏŏ ǇƛƪǎŜƭŀ ǘŀƪ ŀōȅ ƻŘǇƻǿƛŀŘŀƱŀ ǏǊŜŘƴƛŜƧ 

ǿƛŜƭƪƻǏŎƛ ǇƛƪǎŜƭƛ ƻǊȅƎƛƴŀƭƴȅŎƘ 

¶ ǊťŎȊƴƛŜ όƻŘȊƴŀŎȊƻƴŀ ƻǇŎƧŀ Preserve resolution, ȊŘŜŦƛƴƛƻǿŀƴƛŜ ǇŀǊŀƳŜǘǊƽǿ ǎƛŀǘƪƛ ǿ ƻǇŎƧƛ Output 

Parameters) ς ǇƻƴƛȍŜƧ ǇǊȊŜŘǎǘŀǿƛƻƴƻ ǇǊȊȅƪƱŀŘ ŘŜŦƛƴƛŎƧƛ ǎƛŀǘƪƛ ǿ ƻŘǿȊƻǊƻǿŀƴƛǳ 9t{DΥолорΣ ƻ ǿƛŜƭƪƻǏŎƛ 

piksela 1000x1000 ƳΣ ƻōŜƧƳǳƧŊŎŜƧ ȊŀȊƴŀŎȊƻƴȅ ƻōǎȊŀǊ .ŀƱǘȅƪǳ όǿǎǇƽƱǊȊťŘƴŜ ƭŜǿŜƎƻ ƎƽǊƴŜƎƻ i prawego 

dolnego rogu nowej siatki podano na mapce ǿ ǳƪƱŀŘȊƛŜ ǿǎǇƽƱǊȊťŘƴȅŎƘ 9t{DΥолор ς kolorem 

czerwonym i wiersz/kolumna ς kolorem niebieskim) 

 

¦ȍȅǘƪƻǿƴƛƪ ƳƻȍŜ ǿȅōǊŀŏ ƧŜŘƴŊ Ȋ о ƳŜǘƻŘ ǊŜǎŀƳǇƭƛƴƎǳ όƻōƭƛŎȊŜƴƛŀ ǿŀǊǘƻǏŎƛ ǇƛƪǎŜƭŀ ǿ ƴƻǿŜƧ ǎƛŀǘŎŜύΥ 

¶ Nearest ς prȊȅǇƛǎŀƴƛŜ ǿŀǊǘƻǏŎƛ ƳŜǘƻŘŊ αƴŀƧōƭƛȍǎȊŜƎƻ ǎŊǎƛŀŘŀέ 

¶ Bilinear ς ƛƴǘŜǊǇƻƭŀŎƧŀ ǿŀǊǘƻǏŎƛ ƴŀ ǇƻŘǎǘŀǿƛŜ п ƴŀƧōƭƛȍǎȊȅŎƘ ǇƛƪǎŜƭƛ 

¶ Bicubic ς ƛƴǘŜǊǇƻƭŀŎƧŀ ǿŀǊǘƻǏŎƛ ƴŀ ǇƻŘǎǘŀǿƛŜ мс ƴŀƧōƭƛȍǎȊȅŎƘ ǇƛƪǎŜƭƛ όǇƻƭŜŎŀƴŀ ǇǊȊȅ ŘǳȍŜƧ ȊƳƛŀƴƛŜ 

ǿƛŜƭƪƻǏŎƛ ǇƛƪǎŜƭŀ ǿ ǎǘƻǎǳƴƪǳ Řƻ ƻōǊŀȊǳ ƻǊȅƎƛƴŀƭƴŜƎƻύ 
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tƻƴƛŜǿŀȍ ƴƻǿŀ ǎƛŀǘƪŀ ƳƻȍŜ ȊŀǿƛŜǊŀŏ ƻōǎȊŀǊ ƭŜȍŊŎȅ ǇƻȊŀ ȊŀǎƛťƎƛŜƳ ȊƻōǊŀȊƻǿŀƴƛŀ ƴŀƭŜȍȅ ǇƻŘŀŏ ǊƽǿƴƛŜȍ ǿŀǊǘƻǏŏ 

Ƨŀƪŀ ōťŘȊƛŜ ǇǊȊȅǇƛǎŀƴŀ ǇƛƪǎŜƭƻƳ ǿ ǘŀƪƛŜƧ ǎȅǘǳŀŎƧƛ ǿ Ǉƻƭǳ No-data value όƳƻȍŜ ǘƻ ōȅŏ Řƻǿƻƭƴŀ ǿŀǊǘƻǏŏΣ ƪǘƽǊŀ ƴƛŜ 

ǿȅǎǘťǇǳƧŜ ǿǏǊƽŘ ǿŀǊǘƻǏŎƛ ǇŀǊŀƳŜǘǊƽǿΣ ƴǇ. -9999 lub NaN) 

bŀ ǇƻǘǊȊŜōȅ ŏǿƛŎȊŜƴƛŀ w ȊŀƪƱŀŘŎŜ Reprojection Parameters wybierz: 

¶ Predefined CRS: EPSG:3035 ς 9¢w{уф κ [!9! 9ǳǊƻǇŜ όǇƻǎƱǳȍ ǎƛť ƴǊ EPSG w okienku Filter ŀōȅ ǳƱŀǘǿƛŏ 

sobie wyszukanie odwzorowania) 

¶ wťŎȊƴŊ ŘŜŦƛƴƛŎƧť ǎƛŀǘƪƛ όOutput Parameters), ȊƎƻŘƴƛŜ Ȋ ǇǊȊȅƪƱŀŘŜƳ ƴŀ Ǌȅǎǳƴƪǳ ǇƻǿȅȍŜƧ 

¶ wŜǎŀƳǇƭƛƴƎ ƳŜǘƻŘŊ ƴŀƧōƭƛȍǎȊŜƎƻ ǎŊǎƛŀŘŀ 

¶ NaN jako kod braku danych 

Uruchom przetwarzanie przyciskiem RUN. tƻ ǇƻƧŀǿƛŜƴƛǳ ǎƛť ƴƻǿŜƎƻ ǇǊƻŘǳƪǘǳ ǿ ƻƪƴƛŜ Product Explorer Ƴƻȍƴŀ 

ȊŀƳƪƴŊŏ ǇǊƻŘǳƪǘ ȊŀǿƛŜǊŀƧŊŎȅ ǎǳōǎŜǘ ǇǊȊŜŘ ǇǊƻƧŜƪŎƧŊ ƛ ƻǊȅƎƛƴŀƭƴȅ ǇǊƻŘǳƪǘ {о [н όǿ ǘŀƪƛŜƧ ƪƻƭŜƧƴƻǏŎƛύΦ 

¦ǿŀƎŀΗΗΗ tƻ ȊŀƳƪƴƛťŎƛǳ ŜŘȅǘƻǊŀ ǇŀǊŀƳŜǘǊƽǿ ƛ ƧŜƎƻ ǇƻƴƻǿƴȅƳ ƻǘǿŀǊŎƛǳ ƴǇΦ Řƭŀ ǇƻǇǊŀǿƛŜƴƛŀ ƧŀƪƛŜƎƻǏ ǇŀǊŀƳŜǘǊǳ 
ƴŀƭŜȍȅ ŘŜŦƛƴƛŎƧť ǎƛŀǘƪƛ ǿǇƛǎŀŏ ƧŜǎȊŎȊŜ ǊŀȊ όƪŀȍŘŜ ǇƻƭŜύΣ ƴŀǿŜǘ ƧŜȍŜƭƛ ǿȅǏǿƛŜǘƭŀƧŊ ǎƛť ǿŀǊǘƻǏŎƛ wpisane przez 
ǳȍȅǘƪƻǿƴƛƪŀΦ CǳƴƪŎƧŀ ǘŀ Ƴŀ ōƱŊŘ ƛ ǇƻƴƻǿƴŜ ƻǘǿŀǊŎƛŜ ǘŜƎƻ ƻƪƴŀ ǇǊȊŜŘ ǳǊǳŎƘƻƳƛŜƴƛŜƳ ƻōƭƛŎȊŜƵ ǇƻǿƻŘǳƧŜ 
ǇǊȊȅƧťŎƛŜ ǿ ƻōƭƛŎȊŜƴƛŀŎƘ ǿŀǊǘƻǏŎƛ defaultowych. 

W exploratorze windows Ƴƻȍƴŀ ǇƻŘŜƧǊȊŜŏ ǎǘǊǳƪǘǳǊť Ǉƭƛƪƽǿ ȊŀǇƛǎŀƴȅŎƘ ǿ ŦƻǊƳŀŎƛŜ BEAM-DIMAP. 

 

.ťŘȊƛŜ ǘƻ ȊŀǿǎȊŜ ŦƻƭŘŜǊ NazwaProduktu.data ȊŀǿƛŜǊŀƧŊŎȅ ŘŀƴŜ ƻǊŀȊ Ǉƭƛƪ NazwaProduktu.dimΣ ǿ ƪǘƽǊȅƳ ȊŀǇƛǎŀƴŀ 

jest struktura danych. Pƭƛƪ 5La ǎƱǳȍȅ Řƻ ƻǘǿŀǊŎƛŀ ŘŀƴȅŎƘ ǿ {b!tΦ bƛŜ ƴŀƭŜȍȅ ȊƳƛŜƴƛŀŏ ƴŀȊǿ ŀƴƛ ǳǎǳǿŀŏ ŎȊťǏŎƛ 

danych z poziomu exploratora windows ς ƪƻƴƛŜŎȊƴŜ ƻǇŜǊŀŎƧŜ ƴŀƭŜȍȅ ǿȅƪƻƴŀŏ ǿ {b!tΦ 

WYKORZYSTANIE MASEK 

²ȅǏǿƛŜǘƭ ƳŀǇť temperatury powierzchni morza ƪƭƛƪŀƧŊŎ ŘǿǳƪǊƻǘƴƛŜ ƴŀ ǿŀǊǎǘǿť ǊŀǎǘǊƻǿŊ 

sea_surface_temperature (w Product Explorer folder Bands > sea_surface_temperature)Φ tƻǿƛťƪǎȊ Ƴŀƪǎymalnie 

ŎŀƱȅ ƻōǎȊŀǊ όƻǇŎƧŀ Zoom All  w oknie Navigation). 

Flagi ƧŀƪƻǏŎƛ ŘŀƴȅŎƘ ƛ ǿǎǘťǇƴŜƧ ƪƭŀǎȅŦƛƪŀŎƧƛ Ƴƻȍƴŀ ǿȅƪƻǊȊȅǎǘŀŏΣ ŀōȅ ȊŀȊƴŀŎȊȅŏ ƴŀ ƳŀǇƛŜ ƴǇΦ ƻōǎȊŀǊ ƭŊŘǳΣ ƻōǎȊŀǊ 

ǇǊȊȅƪǊȅǘȅ ŎƘƳǳǊŀƳƛ ƛǘǇΦ !ōȅ ǿȅƪƻǊȊȅǎǘŀŏ ƧŜ ƴŀ ŜǘŀǇƛŜ ǿƛȊǳŀƭƛȊŀŎƧƛ ƴŀƭŜȍȅ ǊƻȊǿƛƴŊŏ ƻƪƴƻ Mask Manager 

όǇǊȊŜǿŀȍƴƛŜ ƧŜǎǘ ƻƴƻ ȊǿƛƴƛťǘŜ Řƻ ȊŀƪƱŀŘƪƛ Ǉƻ ǇǊŀǿŜƧ ǎǘǊƻƴƛŜ ƻƪƴŀ ǇǊƻƎǊŀƳǳΣ ƧŜǏƭƛ ōǊŀƪ ǘŀƪƛŜƧ ȊŀƪƱŀŘƪƛ ƴŀƭŜȍȅ 

ƻǘǿƻǊȊȅŏ ƧŜ ǇƻƭŜŎŜƴƛŜƳ View > Tool windows > Mask Manager). 

!ōȅ ǇƛƪǎŜƭŜΣ Řƭŀ ƪǘƽǊȅŎƘ ǿŀǊǘƻǏŏ ǿȅōǊŀƴŜƧ ŦƭŀƎƛ ƧŜǎǘ Ǌƽǿƴŀ ¢w¦9 ȊƻǎǘŀƱȅ ǇǊȊȅǎƱƻƴƛťǘŜ ǇƽƱǇǊȊŜȊǊƻŎȊȅǎǘŊ ǿŀǊǎǘǿŊ 

ƻƪǊŜǏƭƻƴŜƎƻ ƪƻƭƻǊǳ ƴŀƭŜȍȅ ȊŀȊƴŀŎȊȅŏ ǇƻƭŜ ǿȅōƻǊǳ ǇǊȊȅ ƻŘǇƻǿƛŜŘƴƛŜƧ ƳŀǎŎŜΣ ȊŘŜŦƛƴƛƻǿŀŏ ƧŜƧ ƪƻƭƻǊ ƛ ŜǿŜƴǘǳŀƭƴƛŜ 

ȊƳƛŜƴƛŏ ǿǎǇƽƱŎȊȅƴƴƛƪ ǇǊȊŜȊǊƻŎȊȅǎǘƻǏŎƛΦ 

½ŀȊƴŀŎȊ ǿȅǏǿƛŜǘƭŀƴƛŜ ƴŀǎǘťǇǳƧŊŎȅŎƘ ƳŀǎŜƪΥ 

¶ l2p_flags_land ς ǇƽƱǇǊȊŜȊǊƻŎȊȅǎǘŀΣ ȊƛŜƭƻƴŀ 

¶ quality_level_cloud ς ciemnoszara, nieprzezroczysta 

¶ quality_level_worst_quality ς ǇƽƱǇǊȊŜzroczysta, czerwona 

½ŀǳǿŀȍΣ ȍŜ Ƴŀǎƪŀ l2p_flags_cloud ƻōŜƧƳǳƧŜ ƧŜŘƴƻŎȊŜǏƴƛŜ ǇƛƪǎŜƭŜ ƳŀǎƪƻǿŀƴŜ Ȋŀ ǇƻƳƻŎŊ quality_level_cloud 

i quality_level_worst_quality na granicy chmur. Algorytm detekcji zachmurzenia ŎȊťǎǘƻ ōƱťŘƴƛŜ ƛŘŜƴǘȅŦƛƪǳƧŜ 
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ƻōǎȊŀǊȅ ǎƛƭƴȅŎƘ ƎǊŀŘƛŜƴǘƽǿ ǘŜƳǇŜǊŀǘǳǊȅΣ ƪǘƽǊŜ ƳƻƎŊ ǿȅǎǘťǇƻǿŀŏ ƴǇΦ ǇƻŘŎȊŀǎ ȊƧŀǿƛǎƪŀ ǳǇǿŜƭƭƛƴƎǳ 

ǇǊȊȅōǊȊŜȍƴŜƎƻ ƭǳō ǿ ǊŜƧƻƴƛŜ ǊƻȊǇƱȅǿǳ ǿƽŘ ǊȊŜŎȊƴȅŎƘ jako chmury lub ŘŀƴŜ ƻ ƴŀƧƴƛȍǎȊŜƧ ƧŀƪƻǏŎƛ. Maska 

l2p_flags_land ƻōŜƧƳǳƧŜ ǇƛƪǎŜƭŜ ƴŀ ƭŊŘȊƛŜ ǿǊŀȊ Ȋ ǿƻŘŀƳƛ ǏǊƽŘƭŊŘƻǿȅƳƛΦ 5ƻōƽǊ ƳŀǎŜƪ ȊŀƭŜȍȅ ƻŘ ŎŜƭǳ ŀƴŀƭƛȊȅ 

i wizualnej oceny obrazu przed i po zastosowaniu maski. 

 

²ȅōǊŀƴȅ ȊŜǎǘŀǿ ƳŀǎŜƪ ƳƻȍŜ ōȅŏ ŎƘǿƛƭƻǿƻ ǿƱŊŎȊŀƴȅ / ǿȅƱŊŎȊŀƴȅ Ȋŀ ǇƻƳƻŎŊ Layer Manager.  

 






























